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rumore & davvero basso, rispetto all’ampiezza dell’RP, in concomitanza dell’onset.
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Abstract

Il grosso interrogativo che sta alla base dello studio verso la scoperta della
coscienza umana e un dilemma che accomuna gli studiosi di tutti i secoli. Oggi, si
cerca di dare risposte nel tentativo di distinguere i diversi disturbi di coscienza e
di capire, in particolare, come poter interpretare i comportamenti nei pazienti
che si trovano in uno stato di coma. Riuscire a trovare, quindi, un metodo
matematico che riesca in qualche modo ad analizzare i movimenti dei pazienti e
a classificarli come volontari o involontari e cid che ci permette di avvicinarci
guanto piu possibile al loro livello di coscienza. Questo studio parte dalla
rilevazione del segnale EEG e si focalizza su un particolare Event-Related
Potential, che e il Readiness Potential (RP). L'RP € un lento potenziale negativo
che compare nel tracciato EEG a pochi istanti antecedenti al movimento
volontario. Sulla base di questa evidenza & nato un progetto che mira alla
realizzazione di una Brain Computer Interface (BCl). Il mio lavoro di tesi si basa
sulla sperimentazione effettuata su volontari sani attraverso diversi protocolli.
Essenziale e stato I'utilizzo di EEGLAB e in particolare del plug-in MRCPLAB,
attraverso il quale sono stati importati e successivamente manipolati i dati.
Caratteristica predominante dell’attivita elettrica registrata sullo scalpo €
I’abbondante presenza di artefatti. A conseguenza di cio, il mio scopo é stato
quello di sviluppare un metodo finalizzato alla rimozione degli artefatti. E stata
utilizzata la decomposizione nelle Componenti Indipendenti (ICA) e
I'identificazione delle componenti artefattuali € stata messa a punto grazie
all'uso di diversi plug-in. L’obiettivo di questa tesi € quello di studiare differenti
dataset per poter adattare dei criteri opportuni, che mirano all’'ottenimento di
un segnale piu chiaro e quindi piu facilmente interpretabile dal punto di vista

diagnostico.
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Capitolo 1
1.1 Cosa e lacoscienza?

La coscienza e tutto cio che sperimentiamo. Si puo pensare ad essa come cio che
ci abbandona ogni notte quando dormiamo e ritorna al mattino appena svegli.
Senza la coscienza, per quel che ci riguarda, non esisterebbe né un mondo
esterno né noi stessi: non esisterebbe assolutamente nulla. Per comprendere
appieno la coscienza, devono essere analizzate, dapprima, due problematiche.
La prima questione e capire le condizioni che determinano fino a dove e in che
modo un sistema ha una sua coscienza. Ad esempio, qual e il motivo per cui
alcune parti del cervello sono importanti per lo studio della coscienza e altre,
seppur ricche di connessioni neuronali, non lo sono? E come mai siamo coscienti
guando siamo svegli o quando sogniamo, ma non lo siamo quando dormiamo
senza sognare, nonostante il cervello resti attivo? La seconda questione, invece,
riguarda il tipo di coscienza che un sistema ha. Ad esempio, perché i colori li
riconosciamo in quanto tali e in maniera diversa da come percepiamo i suoni o
riconosciamo il dolore? Risolvere il primo problema significa determinare la
“quantita” del livello di coscienza; risolvere il secondo problema, invece, significa

determinare la “qualita” del livello di coscienza.

Sebbene la coscienza sia parte della vita di ognuno di noi, € impossibile riuscire
ad avere la conoscenza della coscienza altrui. Infatti, la nostra capacita di capire
e apprezzare le differenti esperienze degli altri dipende in gran parte dalla loro
autovalutazione e dalla loro abilita di descrivere quell’esperienza. In ogni caso,
in questi ultimi anni e stato identificato un gruppo di pazienti dei quali si riesce a
dimostrare lo stato di coscienza, nonostante essi siano incapaci di parlare o

muoversi, precludendo quindi qualsiasi possibilita di investigare circa la loro
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esperienza cosciente del mondo. Non €& noto che esista un codice neurale
comune, che possa spiegare come individui diversi possano essere accomunati
da esperienze cognitive simili e se cio possa essere utilizzato per interpretarle e
studiarle a fondo. La funzione esecutiva del cervello si riferisce a quei processi
che coordinano e programmano una serie di operazioni cognitive basilari, come
il monitoraggio e I'analisi delle informazioni dall’esterno e I'integrazione di esse
con gliinput interni, cosi come la pianificazione e 'adattamento di nuovischemi
comportamentali sulla base di queste informazioni. Quindi la funzione esecutiva
e parte integrante della nostra esperienza cosciente del mondo, come
conoscenza prioritaria per fare predizioni su eventi futuri. In accordo con cio, la
funzione esecutiva potrebbe fornire una finestra empirica attraverso cui
I’aspetto cognitivo dell’esperienza cosciente umana puo essere quantificato. Le
basi comportamentali e neuronali della funzione esecutiva sono state studiate in
pazienti neuropsicologici che confermano che essa e supportata da una rete di
regioni del cervello, che coinvolgono principalmente i lobi frontali e la corteccia

parietale posteriore.

In termini neurologici, la coscienza puo essere definita sulla base di due termini:
la veglia e la consapevolezza. La veglia indica uno stato in cuisi & vigili, mentre la
consapevolezza si riferisce alla percezione di se stessi e dell’ambiente intorno.
Lo stato di coscienza esiste solo se entrambi gli elementi sono presenti: e
possibile osservare uno stato di veglia in assenza di consapevolezza, mentre non
e mai possibile il contrario. Ognigiorno sperimentiamo una perdita di coscienza
guando ci addormentiamo e lo stesso avviene quando, ad esempio, siamo sotto
I'effetto di anestesia. Questi comunque sono stati temporanei che durano solo
poche ore, molto diversi quindi dallo stato di incoscienza che potrebbe

incombere dopo un trauma o un incidente.
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1.2 Disordini di coscienza

Sembraimmediato, a questo punto, pensare che il modo piu efficace per capire
se qualcuno e cosciente o meno sia chiederlo direttamente alla persona
interessata. In effetti, il gesto piu istintivo che ognuno di noi fa quando incontra
una persona e chiedere come stia e aspettare, quindi, una risposta o al massimo
un movimento, nel caso in cuila persona sia incapace di parlare. In realta, questo
potrebbe essere ingannevole se pensiamo a tutte le intelligenze artificiali che
esistono e che possono parlarci e aiutarci nella vita di tutti i giorni, come se
fossero perfettamente coscienti di sé stesse e del mondo che le circonda. Come
facciamo a definire cosciente un essere non vivente? Per quel che riguarda gli
esseri umani e facile, ovviamente, dire che una persona & perfettamente
cosciente e capace di muoversi e comunicare con l'esterno, ma c’e un’ampia
varieta di condizioni e stati indefiniti che sussistono nel caso in cui una persona,
ad esempio, € in un letto incapace di parlare dopo un incidente e i suoi

movimenti non possono facilmente essere intesi come perfettamente volontari.

Analizzando quali possono essere gli stati in cui un paziente non e capace di
comunicare in maniera cosciente con l'esterno, possiamo evidenziare una

differenza tra coma, stato vegetativo e stato di minima coscienza.
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Figura 1: grafico riassuntivo che mostra i differentidisordinidi coscienza

Quando parliamo di coma, ci riferiamo ad uno stato di sonno profondoin cuinon
vi & reattivita da parte del paziente, il quale non riesce a svegliarsi a causa di una
problematica al sistema nervoso. Un paziente solitamente esce dallo stato di
coma quando si sveglia e riprende il normale ciclo sonno-veglia, ma questo non
comporta necessariamente una ripresa di coscienza. Il coma, quindi, differisce
dal sonno, in quanto l'individuo e incapace di percepire e rispondere a stimoli
esterni e a necessita interne e quindi non riesce ad essere svegliato.
Contrariamente alla credenza popolare, i pazienti in stato comatoso possono

mostrare segni di movimento, possono produrre suoni e mostrarsi agitati.

Lo Stato Vegetativo (VS), invece, appare dopo il coma, quando un paziente
riacquisisce correttamente il ciclo veglia-sonno. In questo caso non ci sono
risposte agli stimoli o a semplici comandi, ma si possono osservare alcuni

movimenti non intenzionali e riflessi automatici.

Infine, lo Stato di Minima Coscienza (MCS) comprende in generale un’ampia
gamma di stati non perfettamente definiti in cui il paziente non riesce a
comunicare con il mondo esterno, ma ci sono dei segni di movimenti non
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automatici. A differenza dello stato vegetativo, nel caso di minimo livello di

coscienza e possibile riottenere il pieno stato cognitivo dopo parecchianni.

Lo Stato Locked-in (LIS) avviene quando un paziente, in seguito al coma,
riacquisisce non soltanto un corretto ciclo veglia-sonno, ma anche una piena
coscienza di se stesso e del mondo intorno. A causa di un danno neurologico, in
ogni caso, resta permanentemente paralizzato ed € incapace di comunicare ed
esternare la propria condizione, almeno in una prima fase. La maggior parte dei
pazienti in questo stato, comunque, riescono a recuperare la capacita di
muovere gli occhi, in quanto questi movimenti non dipendono dal sistema
nervoso centrale, in modo da riuscire nuovamente a comunicare con il mondo

esterno.

Infine, lo stato totale di Locked-in & una condizione molto rara di Locked- in, in
cui sfortunatamente il paziente non riesce neanche a muovere gli occhi. A causa
della totale incapacita di comunicazione di questo stato, € praticamente
impossibile stimare correttamente quante persone siano effettivamente sotto

guesta condizione.

1.3 Neurofisiologia

E fondamentale avere la consapevolezza che ci sono alcuni aspetti dell’attivita
cerebrale che possono spiegare la presenza dello stato di coscienza e che
possono essere usati, quindi, come punto di partenzadi questo studio. Per capire
quali aspetti dell’attivita cerebrale giocano un ruolo fondamentale nella
definizione di coscienza, dobbiamo focalizzarci sul sistema nervoso centrale
(SNC) e in particolare sul cervello umano. Il sistema nervoso centrale é

responsabile del controllo e della regolazionedi ogni attivita e funzionedel corpo
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umano. Esso svolge la funzione di rielaborare tutte le informazioni che vengono
raccolte dal sistema nervoso periferico e di distribuirle attraverso lo stesso
sistema. Nello specifico, € responsabile delle funzioni psichiche e intellettive,
come la memoria, la coscienza e conoscenza, ma anche respirazione e battiti
cardiaci. E composto dal cervello e dal midollo spinale: entrambi sono immersi
in un liquido di protezione, avvolti da membrane dette meningi e protetti a loro
volta da un rivestimento osseo. | tessuti che formano il sistema nervoso centrale

sono detti neuroni e si dividono in sostanza grigia e sostanza bianca.

1.4 Anatomiadel cervello umano

Possiamo identificare tre differentiregioni: il cervello, il cervelletto e la corteccia
cerebrale. Il cervello gioca un ruolo importante nella regolazione delle funzioni
basilari, come il ciclo di sonno e le attivita cardiache e respiratorie. Il cervelletto,
invece, controlla la postura, coordina i movimenti e si interessa degli stimoli
esterni. La corteccia cerebrale, infine, & fondamentale per la memoria,
I’attenzione, la percezione, il pensiero ed il linguaggio. Si puo dividere in due

emisferi, destra e sinistra, e in quattro regioni, detti lobi:

e Lobo frontale: € la corteccia motoria primaria, responsabile della parola e
della personalita.

e Lobo parietale: incaricato dell’elaborazione degli stimoli, in particolare
per il dolore, il tatto, la temperatura e il linguaggio.

e Lobo temporale: responsabile dell’udito e dell’olfatto, memoria visiva,
comprensione del linguaggio e associazione di emozioni.

e Lobo occipitale: € incaricato dell’elaborazione degli stimoli visivi, la

differenziazione dei colori e la percezione del movimento.
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Figura 2: Visione esternadell’'Encefalo

Parietale

Occipitale

Cervelletto

La lesione di unsolo lobo, ad esempio in caso di trauma o emorragia ben

localizzati, & capace di determinare un danno solo alle funzioni svolte da quel

dato lobo, mentre le funzioni degli altri lobi potrebbero restare intatte: ad

esempio la lesione del lobo occipitale potrebbe determinare lesioni alla vista, ma

lasciare intatte le altre funzioni cerebrali, mentre lesioni della corteccia

prefrontale potrebbero determinare perdita dell’inibizione dei comportamenti

antisociali, lasciando intatte le altre funzioni del cervello.

| lobi del cervello risiedono tutti all'interno del “neurocranio”, anche chiamato

“scatola cranica”. Ogni lobo e protetto dall'osso omonimo del neurocranio,

avremo quindi:
« 0sso frontale: protegge il lobo frontale;
= 0SS0 parietale: protegge il lobo parietale;

» 0sso temporale: protegge il lobo temporale;
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= 0SS0 occipitale: proteggeil lobo occipitale.

Il sistema talamocorticale, che corrisponde al talamo e alla corteccia cerebrale,
insieme con il cervelletto, contiene i neuroni, cellule che ricevono, processano e
trasmettono informazioni, attraverso segnali elettrici e chimici. Mentre Ia
presenza dei neuroni € un segnale di grande trasmissione di informazione, sia
per le sensazioni che per le azioni, non € invece conseguenza naturale della
presenza di coscienza. Testimonianza di cio e il fatto che il cervelletto possiede
un enorme numero di neuroni, ma noi sappiamo da esperienza che la vita inuno
stato di coscienza pu0 andare avanti anche in sua totale assenza. | pazienti per i
quali risulta necessario rimuovere il cervelletto, per esempio, a causa di un
tumore, si devono sforzare per parlare fluentemente e riuscire a coordinare i
movimenti, ma non c’é rischio per loro di perdere lo stato di coscienza, infatti
continuano a provare sensazioni, percepire colori e forme, sentire suoni e
sperimentare gusti. Il sistema talamocorticale, invece, presenta un minor
numero di neuroni ma ha un ruolo rilevante nell’esperienza cognitiva. Un danno
importante a questo sistema puo cancellare completamente per un soggetto una

dimensione dell’esperienza cognitiva, come ad esempio la percezione visiva dei

colori.
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Capitolo 2
2.1 EEG

Essere capaci di leggere un tracciato EEG e un’abilita che riguarda sia la scienza
che I'arte. La maggior parte delle persone impara pian piano con I'esperienza o

tramite qualcuno che € gia esperto.

Un tracciato EEG registra attivita elettrica dalla corteccia cerebrale. Poiché
I’attivita viene misurata in microvolt, deve essere certamente amplificata per
essere poi mostrata su uno schermo. La maggior parte di cio che si registra ha
origine proprio nei neuroni, poi ci sono varie possibili altre risorse come i
potenziali d’azione, i potenziali post sinaptici e la depolarizzazione dei neuroni.
L’azione dei potenziali introduce una breve corrente nell’assone con un campo
di potenza molto limitato, questo quindi li rende improbabili candidati. Per quel
che riguarda, invece, i potenziali post-sinaptici, essi hanno un campo molto piu
ampio e quindi sono frai primi generatori del segnale elettroencefalografico. La
depolarizzazione dei neuroni, infine, puo avere anche un ruolo importante e
produce per certo cambiamenti nel tracciato EEG. Inun cervello sano, i potenziali
d’azione viaggiano lungo l'assone fino al nervo terminale, dove verra poi
rilasciato un neurotrasmettitore. In ogni caso, i potenziali sinaptici sono la piu
importante risorsa per [Ielettroencefalogramma. L'essenza dellEEG e
I’amplificazione di piccole correnti in una rappresentazione grafica che puo
essere mostrata e analizzata. Naturalmente, i potenziali extra-cerebralisono allo
stesso modo amplificati, come i movimenti occasionali che capitano durante una
registrazione ed essi hanno un’ampiezza che misura svariate volte quella dei
potenziali corticali. Ragione per cui, queste interferenze e artefatti oscurano il

tracciato EEG.
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La rilevazione del segnale EEG avviene grazie all’utilizzo di elettrodi: essi sono
generalmente piccoli, si presentano come dischi metallici non reattivi applicati
allo scalpo con una pasta conduttiva. Possono essere utilizzati diversi tipi di
metalli, come oro, argento, cloruro di argento, platino. Il contatto dell’elettrodo
deve essere ben saldo per riuscire ad assicurare bassa impedenza (resistenza al
flusso di corrente), cosi da minimizzare sia gli artefatti dovuti agli elettrodi stessi
che quelli dovutiall’ambiente circostante. Per una registrazione a lungo termine,
specialmente se il paziente riesce a muoversi, la cuffia di elettrodi deve essere
fissata con una sorta di colla e un gel conduttivo deve essere inserito fra
I’elettrodo e lo scalpo, attraverso un piccolo foro presente nell’elettrodo stesso.
Questa procedura riesce a preservare |'integrita per un periodo prolungato. Altri
tipi di elettrodi possono essere utilizzati, come la plastica oppure elettrodi ad
ago. ll posizionamento degli elettrodi e standardizzato negli Stati Uniti, cosi come
in altre nazioni. Cido permette di interpretare un tracciato EEG registrato in un
laboratorio, in qualunque altro posto. Il problema generale € quello di registrare
I’attivita da diverse parti della corteccia cerebrale in una maniera logica ed
interpretabile. Grazie al Dr. Herbert Jasper, un rinomato esperto di
elettroencefalografia, ad oggi abbiamo un sistema logico e accettato per il
posizionamento degli elettrodi. Il suo nome inizialmente era Sistema 10-20, ma
poi e stato cambiato in sistema 10-10, perché & cambiato il numero di elettrodi
utilizzati. Entrambi i sistemi, comunque, dipendono dall’accuratezzadella misura
del cranio, che essenzialmente pud essere diviso in tre aree: piano sagittale,
coronale e orizzontale. Gli elettrodi il cui numero di riferimento & pari sono

posizionati sul lato destro, i dispari sul lato sinistro.

Il segnale EEG pu0 essere rilevato in svariate condizioni, ma la piu solita e
semplicemente quandoil segnale e rilevato sullo scalpo e in questo caso stiamo

considerando un segnale EEG spontaneo. Si puo chiedere, inoltre, al soggetto di
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svolgere attivita semplici, come ad esempio chiudere gli occhi, provocando cosi
una variazione della densita spettrale di potenza del segnale. Oppure si puod
chiedere al soggetto di osservare un filmato, ascoltare della musica o
semplicemente meditare. In questo modo potremmo accorgerci che il segnale
varia a seconda delle diverse zone dello scalpo. Il segnale EEG spontaneo &
assimilabile ad un processo casuale, cido significa che non e facilmente
interpretabile dal punto di vista morfologico e inoltre vuol dire che & molto
variabile da soggetto a soggetto, anche a seconda di cid che sta facendo, ancor
di piu in condizione patologiche. In un soggetto normale, la fascia al 95% del
segnale puoO essere compresa tra piu e meno 50 micro Volt. In condizioni
patologiche, questa fascia pu0 variare molto di piu, il segnale puo diventare
anche 10 volte piu ampio, provocando cosi un cambiamento delle caratteristiche
statistiche del segnale stesso. Normalmente, negli esami tradizionali, dal punto
di vista della banda, si considera un segnale con frequenze comprese tra 0,1 Hz
e 40 Hz. Ma e possibile che si arrivianche ad 80 Hz. Il segnale EEG & suddiviso in
alcune sotto bande: banda delta, teta, alfa, betal, beta2 e gamma. La banda alfa
vada7Hzal4Hz la bandateta vada3,5Hza 7 Hz; la banda delta va da 0,3 Hz
a3,5Hz;labandabetal vada 14 Hza 21 Hz;la bandabeta2 vada 21 Hza 40 Hz;
negli ultimi anni si considera anche una banda gamma che arriva ad 80 Hz.
L’attivita in alcune di queste specifiche bande e caratteristica di alcune situazioni
in un soggetto normale. Ad esempio la banda alfa e tipica del rilassamento,

mentre le bande delta e teta entranoin gioco in situazioni diforte stress o sonno.

Se decidiamo di non registrareil segnale EEG sullo scalpo, possiamo considerare

di farlo direttamente sulla dura madre o addirittura all’interno dell’encefalo.
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Figura 3: Tracciato EEG dei diversitipi di onde cerebrali

2.2 Sistema 10-20

Argomento molto delicato € il posizionamento degli elettrodi: oggi ci si riferisce
al cosiddetto sistema 10-20 che di seguito sara illustrato. Iniziamo dal primo
punto di riferimento che e la fossetta Nasion, da questo punto percorriamo il
cranio lungo la linea mediana, fino ad arrivare ad un punto in cui si sente una
sporgenza, si tratta di Inion. A questo punto misuriamo la distanza che intercorre
tra Nasion e Inion e la dividiamo per 10; questa distanza risultera diversa da
soggetto a soggetto. Se partiamo da Nasion, al primo posto, ad una distanza del
10% troviamo l'elettrodo Fpz, se da esso mi muovo del 20% arrivo ad un
elettrodo frontale che si chiama Fz. Proseguendo ancora del 20% trovo Cz e poi
Pz, fino ad arrivare all’elettrodo occipitale Oz, che si trova ad una distanza del
10% da Inion. La stessa cosa va fatta anche per la distanza che intercorre fra i
due punti preauricolari. Se parto da sinistra, trovero T3 perché sono arrivato
all'osso temporale, successivamente ci sara C3; alla destra di Cz invece, trovo C4
e T4. 1 19 punti standard utilizzati per registrare un segnale EEG attraverso il

sistema 10-20 sono quelli sopracitati, insieme con F3, F7, F4, F8, P3, T5, P4, T6,
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O1e 02. Il sistema prende il nome dal fatto che gli elettrodi si trovano sempre
ad una distanza del 10% o del 20% della distanza tra Inion e Nasion e della
distanza frai due punti preauricolari. Spesso si aggiungono anche gli elettrodi Oz
e Fpz, arrivando cosi a 21. Si capisce immediatamente che una preparazione di
guesto tipo non e velocissima, allora si & pensato di utilizzare delle cuffie divarie
dimensioni che mettono gli elettrodi pil o meno nelle posizioni corrette.
Ovviamente grazie all’utilizzo di queste cuffie, il tempo di preparazionesi riduce,
ma € importante che ciascun elettrodo sia sempre verificato e riempito di gel.
Questo e ci0o che si fa quando si vuole eseguire una registrazione EEG
tradizionale, altrimenti si puo fare un EEG a risoluzione piu alta, utilizzando
guesto stesso sistema, ma spostandosi sempre del 10% della distanza. Quando
si usano piu di 48 elettrodi, si dice che si sta effettuando un EEG ad alta
risoluzione. Oggi esistono sistemi che permettono di acquisire segnali fino a 512
punti diversi sullo scalpo, ovviamente non e possibile con elettrodi di superficie,

ma si devono utilizzare piccoli aghi da inserire sottocute.

Fp: frontale anteriore
F: frontale

T: temporale

C: centrale

P: parietale

O: occipitale

z: linea mediana

dispari: sinistra pari: destra

Figura 4: le posizioni degli elettrodie i loro nomi sono specificati dal sistemainternazionale 10-20,

utilizzato nella maggior parte delle applicazioni cliniche e di ricerca.
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Dal punto di vista degli elettrodi di riferimento, essi possono essere messi dietro
all'orecchio sull’osso mastoide, oppure se voglio un unico riferimento centrale
posso posizionarlo sul mento. Ci sono, inoltre, anche diversi modi di posizionare

gli elettrodi: faremo ora riferimento ad un sistema monopolare o bipolare.

Figura 5: a sinistra, esempio di misura bipolare; a sinistra, esempio dimisura monopolare.

Se guardiamo al caso B, il potenziale di ogni elettrodo viene rilevato rispetto al
riferimento. Sto effettuando in questo caso una misura monopolare, perché sto
misurando il potenziale di un unico elettrodo rispetto a riferimento. Nel caso A,
invece, il prelievo e bipolare perché si effettua una differenza di potenziale e con

guattro elettrodi posso avere solo tre canali.

Riconoscere gli artefatti € uno degli aspetti piu intricati e al tempo stesso
soddisfacenti nell’interpretazione di un tracciato EEG, cosi come una delle cose
piu importanti. Gli artefatti possono essere di differenti forme e possono essere
causati da diversi fattori. La maggiore problematica deriva dall’enorme
amplificazione richiesta che serve, appunto, per registrare le onde. Come
risultato, quindi, i potenziali non cerebrali che vengono amplificati, come ad

esempio grandi movimenti da parte del paziente che producono escursioni
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casuali nella conduzione degli elettrodi, possono rendere il tracciato EEG

incomprensibile.

2.3 Tipi di artefatti

Nonostante lo scopo del tracciato EEG € quello di registrare, appunto, attivita
cerebrale, esso nella realta rileva attivita elettrica anche da siti che non siano il
cervello. Cio che quindi non riguarda il cervello puo essere diviso in artefatto
fisiologico o non fisiologico. Mentre gli artefatti fisiologici sono generati dal
paziente, quindi non derivano dal cervello ma sono comunque provocati dal
corpo umano, gli artefatti extra-fisiologici provengono dall’esterno. Il processo
sistematico di riconoscimento, identificazione della causa ed eliminazione
dell’artefatto € molto importante al fine di ridurre la possibilita di una cattiva
interpretazione dell’EEG e per limitare potenziali conseguenze cliniche avverse.
L’attivita fisiologica ha un campo di distribuzione topografica logica con una
caduta di potenziale di tensione prevedibile, mentre gli artefatti hanno una
distribuzione illogica, che si allontana dai principi di localizzazione attesi.
Possiamo suddividere gli artefatti in differenti categorie: artefatti cardiaci,
artefatti dell’elettrodo, artefatti dovuti alla strumentazione, artefatti muscolari

e artefatti oculari.

2.3.1 Artefatti cardiaci

Il cuore produce due tipi di artefatti: elettrici e meccanici. Entrambi sono bloccati
nel tempo dalle contrazioni cardiache e sono piu facilmente riconoscibili grazie

alle loro sincronizzazioni nei complessi del canale ECG. Essenzialmente,
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I’artefatto cardiacoelettrico € un complesso QRS chesi € formatoin malo modo.
Un artefatto di questo tipo potrebbe capitare non in maniera costante con ogni
contrazione del cuore e potrebbe avere un intervallo irregolare quando e
presente un’aritmia cardiaca. In qualunque situazione, potrebbe essere
identificato attraverso I'associazione temporale con i complessi QRS nel canale
ECG. Per quanto riguarda I'artefatto cardiaco meccanico, invece, esso puo
comparire attraverso la pulsazione circolatoria e potrebbe essere considerato
anche un tipo di artefatto d’elettrodo. Esso si verifica quando un elettrodo si
trova su unvaso sanguigno e si manifesta come un’onda periodica piu lenta con
un intervallo regolare che segue il picco dell’artefatto ECG a circa 200 milli
secondi. Accade piu comunemente in corrispondenza delle regioni frontali e

temporali e meno comunemente presso quella occipitale.
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2.3.2 Artefatti d’elettrodo

Gli artefatti d’elettrodo di solito si manifestano come transizioni brevi limitate
da un elettrodo e da una bassa frequenza. Queste brevi transizioni sono dovute
ad una spontanea fuoriuscita di potenziale elettrico che era presente tra
I’elettrodo e la testa. Questa spontanea fuoriuscita riflette I'abilita dell’elettrodo
e delle superficie della pelle di funzionare come un capacitore e come
immagazzinatore di carica elettrica. Con il rilascio di carica c’e un cambio di
impedenza e all'improvviso appare un potenziale in tutti i canali che includono

I’elettrodo.

Esistono numerosi tipi di fonti esterne che producono artefatti e che potrebbero,
attraverso il campo elettrico che generano, provocare effetti sul corpo umano. Il
piu comune tra gli artefatti dovuti a fonti esterne e causato dall’alternanza di
corrente elettrica presente. Il rumore e solitamente medio a bassa ampiezza ed
e circa a 50 Hz. La difficolta nel discriminare questo tipo di artefatti si risolve
abbastanza facilmente poiché essi producono forme d’onda che sono molto

diverse dalle onde generate dall’attivita cerebrale.
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Figura 7: Tipiche oscillazioni di un movimento d’elettrodo
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2.3.4 Artefatti muscolari

Movimenti durante la registrazione di un tracciato EEG possono produrre

artefatti, sia attraverso il campo elettrico generato dal muscolo sia attraverso

I'effetto del movimento tra il contatto dell’elettrodo e la pelle. Nonostante i

campi di potenziale muscolare sono dei segnali riconosciuti dagli elettromiografi,

essi rappresentano del rumore per gli elettroencefalografi. Infatti, I'attivita

dellEMG & la pit comune e importante fonte di rumore che si riversa nell’EEG.

Essa riesce ad oscurare |'attivita cerebrale a causa della sua maggiore ampiezza

e frequenza. La durata dell’artefatto muscolare varia in accordo con la durata

dell’attivita muscolare, cosi come la distribuzione. In ogni caso |'artefatto capita

pil comunemente nelle regioni sottostanti al muscolo.
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Figura 8: i potenzialiche si evincono sull’elettrodo T3 sono artefatti muscolari; la duratadei

potenziali & pill breve di quella dei picchi generatidal cervello.
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2.3.5 Artefatti oculari

La maggior parte degli artefatti oculari sono causati dal dipolo elettrico di ciascun
occhio che si aggira attorno ai 100 milli Volt. Il dipolo si orienta lungo I'asse che
congiunge la cornea e la retina ed €& positivo nella direzione della cornea,
negativo nella direzione della retina. Il dipolo assume rilevante importanza nella
registrazione EEG quando diventa un campo elettrico in movimento e cio capita
a causa della chiusura e apertura della palpebra. | battiti, infatti, producono
artefatti oculari proprio perché sono movimenti molto rapidi. Ci accorgiamo di

battiti che si ripetono quando vediamo sul tracciato una sequenza di onde lente.
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Figura 9: Gli artefatti oculari sono caratterizzati da movimentiampi e lenti, che si evincono sul

tracciato.

2.4 Correzione e rimozione degli artefatti

Gli artefatti sono solitamente riconosciuti da esperti nella lettura dei tracciati
EEG. Il processo di analisi visiva, di rimontaggio e di filtraggio digitale permettono

I'identificazione della maggior parte degli artefatti, fisiologici e non. Esaminare
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un’epoca di EEG in un differente montaggio potrebbe permettere all’esperto di

determinare che una particolare forma d’onda non ha un campo fisiologico e

cosi potrebbe essere pil certamente un artefatto. Un’idea potrebbe essere

quella di applicare dei filtri digitali e cio potrebbe migliorare notevolmente

I'interpretazione dellEEG contaminato da artefatti, facendo in modo che

specifiche frequenze siano cosi rimosse. | metodi pil comunemente utilizzati per

la rimozione di artefatti sono:

Uso di filtri passa-banda, nel caso in cui I'analisi e ristretta a specifiche
bande di frequenza. In questa situazione si potrebbe implementare un
algoritmo automatico che analizzi I'attivita solo nella specifica banda di
frequenza. Questo metodo, pero, non € molto utilizzato per I'analisi
dellintera banda del segnale EEG, in quanto gli artefatti possono
comparire a qualunque frequenza. Inoltre, il processo di filtraggio
potrebbe alterare il segnale EEG, con conseguente possibilita di
individuazione degli artefatti molto bassa.

Rimozione manuale degli artefatti, nel caso in cui un tecnico o un esperto
effettua una revisione dell’intera registrazione e marca i segmenti con
artefatti. Questo & un metodo affidabile e potrebbe evidenziare alcuni
artefatti non riconosciuti da tecniche automatiche. Ovviamente risulta
essere una procedura lunga e faticosa che potrebbe diventare
problematica, soprattutto in presenza di lunghe registrazioni. Inoltre
piccoli artefatti potrebbero non essere identificati e differenti individui
potrebbero scegliere soglie differenti per la rimozione. Questo metodo,
dunque, e possibile sono per un’analisi digitale offline, quindi non in
tempo reale.

Rimozione automatica degli artefatti: questa tecnica rigetta brevi artefatti

se un determinato segmento del segnale supera delle soglie predefinite.
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Queste soglie possono essere delle semplici analisi dei canali stessi
dellEEG. Ad esempio, se un segmento mostra un’ampiezza molto elevata,
sara eliminato. Alcune tecniche usano ulteriori elettrodi per identificare i
segnali con artefatti, come EOG, EMG, EKG o accelerometri. Questa
tecnica puo essere usata online o offline. La rimozione automatica non
riesce ad identificare tutti i possibili artefatti, specialmente nel caso di
pazienti malati oin ambienti elettricamente ostili. L’elemento a sfavore di
guesta tecnica e che, dal momento in cuiun intero segmento di EEG viene
rimosso se supera la soglia prefissata, allora potrebbe accadere che viene
eliminata anche una porzione del segnale EEG che e utile. Si mira a
decomporre il segnale in componenti indipendenti, alcune
rappresenteranno il segnale EEG, altre rappresenteranno I'artefatto. Una
volta che la componente dell’artefatto viene identificata, sara poi rimossa
e la restante parte del segnale pud essere ricomposta. Esempi di questi
metodi includono l'utilizzo di filtri spaziali e analisi ai componenti
indipendenti (ICA). Algoritmi basati su forme d’onda e reti neurali
permettono I'utilizzo di questo metodo per una piu ampia varieta di

artefatti.

Per stabilire se un paziente e clinicamente in uno stato di coma, piuttosto chein

uno stato vegetativo o di minima coscienza, i medici devono fare diagnosi

appropriate, attraverso I'osservazione del comportamento stesso del paziente.

Per evitare di arrivare a conclusioni errate e quindi di presentare una diagnosi

lontana dalla realta, le osservazioni sul comportamento del paziente devono

essere integrate con tecniche di neuroimaging ed elettrofisiologiche. In

particolare, per scoprire una funzione cognitiva in pazienti non responsivi

attraverso un comando motorio riproducibile, che € un segno di coscienza, si

utilizza una componente ERP (Evoked-Related Potential) collegata al movimento
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volontario intenzionale che e il Readiness Potential. Questo progetto
approfondisce il significato di Readiness Potential e delle sue componenti in
soggetti sani sotto condizioni sperimentali differenti, per creare una scala di
misurazioni, che permette di distinguere tra movimenti volontari, semivolontari
e involontari. Questo potenziale e bloccato nel tempo da stimoli esterni a causa
del movimento del dito indice acquisito attraverso il segnale EMG e lo rende un
MRP (Movement Related Potential), ottenuto dalla media del segnale EEG diviso
in epoche. L’obiettivo principale di questo progetto € quello di sviluppare una
Brain Computer Interface (BCl) basata sul riconoscimento dei Readiness
Potential nel segnale EEG per permettere a pazienti, la cui diagnosi € quella di
uno stato vegetativo o di minima coscienza, un canale di comunicazione
artificiale per poter dialogare con il mondo esterno. In questo modo, da un punto
di vista diagnostico, sara possibile ottenere maggiori informazioni riguardo il
reale stato di coscienza di pazienti, quindi riuscire anche ad indentificare
tecniche riabilitative; dall’altro lato, se pensiamo alla qualita della vita dei
pazienti stessi, si evince per loro la possibilita di comunicare con il mondo
esterno e questo puo portare a nient’altro che benefici significativi, sia fisici che

psicologici.
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Figura 10: grafica riassuntivadi differentitipologie di artefatti

2.5 Evoked-Related Potential (ERP)

La tecnica basata su ERP fornisce un metodo potente nell’esplorazione della
mente umana e del cervello. Nella maggior parte dei casi, i potenziali evocati si
originano come potenziali postsinaptici, che accadono quando i
neurotrasmettitori si legano airecettori, cambiando il flusso degli ioni attraverso

la membrana della cellula.

Gli ERP sono potenziali elettrici associati a specifici eventi, quindi delineano le
risposte a stimoli visivi, sensoriali, uditivi e somatosensoriali, includendo anche
processi relativi a movimenti volontari. Infatti la preparazione del movimento
stesso produce un’onda riconoscibile sul tracciato, prima del movimento
effettivo. L'onda di un ERP consiste in una sequenza di deflessioni in tensione
positive e negative ed e rappresentata dalla sua polarita, latenza e distribuzione
sullo scalpo. La tecnica ERP misura una funzione corticale bloccata nel tempo tra
i 100 e i 1000 milli secondi dopo uno stimolo e rappresenta un metodo non

invasivo per indentificare componenti fisiologiche che contribuiscono al
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processo selettivo cognitivo e per ricevere informazioni riguardo a come la

corteccia processa i segnali e prepara le azioni.

Ci sono molti comuni artefatti che sono rilevati attraverso le registrazioni EEG e
richiedono un trattamento speciale. Il piu comune di questi deriva dagli occhi.
Quando si chiude la palpebra, si puo osservare una grande deflessione della
tensione e questo tipo di artefatto e solitamente piu grande di un segnale ERP.
Questi grandi potenziali possono confondere lo sperimentatore che utilizza

stimoli laterali e si focalizza sui risultati degli ERP.

2.6 Readiness Potential (RP)

Readiness Potential (RP), detto anche Bereitschaftspotential (BP), € un lento
potenziale negativo che deriva dallEEG che si trova proprio nei secondi che
precedono le azioni volontarie. Teorie recenti suggeriscono che I'RP rifletta la
media di fluttuazioni stocastiche che si accumulano durante I'attivita cerebrale,
legate ad un specifico segnale relativo ad un’azione volontaria. Ovvero gli eventi
legati a RP dovrebbero essere ampiamente presenti, anche in assenza di azioni.
Le azioni volontarie, quelle causate da processi interni e non da stimoli esterni,
hanno un segno distintivo rispetto alle azioni che avvengono in risposta
allambiente. Cosa rappresenta I’'RP? La visione convenzionale & che RP riflette
la preparazione dell’azione nell’area motoria e premotoria, che inizia quando la
parte inconscia decide di agire e ha il suo culmine con il comando motorio che
viene trasmesso tramite la corteccia motoria primaria. Questa considerazione
implica, in primo luogo, che I'RP & specifico per azioni volontarie: dovrebbe
quindi capitare giusto prima delle azioni volontarie, ma non prima di quelle
involontarie. In secondo luogo, I'RP non dovrebbe esplicitarsi quando I'individuo

vorrebbe produrre un’azione volontaria, ma nella realta non lo fa. La prima
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considerazione e stata supportata, mentre la seconda é piu difficile da validare.
L'RP che precede le azioni volontarie non puo essere facilmente individuato
attraverso esperimenti individuali, a causa della sua piccola ampiezza comparata
al rumore inerente alle registrazioni EEG. Come conseguenza, I'RP e studiato
tipicamente sulla media di un gran numero di esperimenti, bloccati nel tempo

I”

rispetto alla durata dell’azione. Ogni evento EEG “single-trial”, simile all'RP, che
non porta ad alcuna azione, potrebbe essere non definito. Quindi, questa
interpretazione convenzionale dell'RP & spesso collegata all’azione volontaria: &
possibile che gli eventi legati agli RP avvengano sempre, o almeno avvengano
anchein tempi che non sono relativiad azioni volontari. Recentemente, Schurger
e altri ricercatori hanno proposto un’interpretazione alternativa dell’RP, che
pone una questione ancora piu interessante. Hanno dimostrato che I'RP
potrebbe riflettere un evidente accumulo di una soglia interna. Ciog, in assenza
di un’evidenza esterna, l'accumulatore integra fluttuazioni stocastiche
neuronali, producendo un processo casuale che fa in modo che I'accumulatore
raggiungala soglia. Quando tracce che derivano da esperimenti multipli prodotti
da questo modello sono bloccate nel tempo all’istante in cui viene raggiunta la
soglia, che e il tempo in cui avviene |'azione, esse riprodurranno la forma di un
RP mediato. Questo indica che il segnale RP potrebbe riflettere lo stato di questo

accumulatore. Quindi, la forma caratteristica dell’RP potrebbe ricordare quella

di un artefatto.

Shibasaki e Al., invece, propongono un’altra visione del BP che prevede la
divisione in due segmenti: la prima parte detta “early BP” e la seconda parte

detta “late BP”.
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Figura 11: Forme d’ondadi un MRCP di un singolo soggetto. “Early BP” ha inizio a circa 1,7 s prima

dell’onsetsulla mediaed & massimo sulla linea centrale dell'elettrodo (Cz). “Late BP” invece inizia

300 ms prima delllEMG onset ed € molto pil ampio rispetto alla regione controlaterale del

movi

mento.

Il primo segmento, “early BP”, riflette I'insieme dei processi cognitivi come

I’attenzione, lo stato preparatorio, la selezione del movimento, I'intenzione di

agire che resta inconscia per un breve periodo, mentre il secondo segmento,

“late BP”, prima di arrivare al picco, & influenzato dal movimento stesso dettato

dalla precisione, lo sforzoe la complessita. Per questa ragione, il primo segmento

puo essere connesso all’intenzione no
accadra, mentre il secondo segmen

movimento.

n ancora cosciente del movimento che

to potrebbe riflettere la volonta del

2.7 Lateralized Readiness Potential (LRP)

LRP misura la lateralizzazione di BP e

riflette la preparazione motoria di una

mano prima dell’inizio dell’esecuzione del movimento. Deriva dai potenziali
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presenti sullo scalpo. Inizialmente, I'RP € equamente distribuito su entrambe gli
emisferi, poi inizia a lateralizzarsi prima dell'inizio del movimento, con
un’ampiezza maggiore nell’emisfero controlaterale al movimento. La
lateralizzazione € massima in corrispondenza della corteccia motoria. Per
ottenere LRP, si ricorre ad un metodo semplice che consiste nel sottrarre segnali
dall’emisfero concordeal movimento rispetto a quello controlaterale allo stesso.
Oppure si pud utilizzare anche un metodo con una doppia sottrazione in

sequenza.
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Capitolo 3

3.1 Protocollo sperimentale

I mio lavoro di tesi & partito con una fase sperimentale presso il “Centro Puzzle”
di Torino. Le registrazioni EEG sono state acquisite su volontarisani, di entrambi
i sessi, di eta compresatrai 23 ei26,grazie all'utilizzo del software Galileo NT.
Queste registrazioni sono state effettuate con 34 elettrodi passivi in
Argento/Argento Cloruro, ai quali sono stati aggiunti due elettrodi ai lobi, inoltre
la frequenza di campionamento € stata impostata ai 512 Hz. Durante
I'acquisizione EEG, & stato possibile registrare anche I'EOG, grazie al
posizionamento di due elettrodi adesivi sopra e sotto ciascun occhio, per
incentivare la rimozione di artefatti oculari. E stato deciso di avere il soggetto
performante che effettua il movimento del dito, registrando il segnale EMG.
L’inizio del movimento del dito e stato monitorato attraverso il posizionamento
di due elettrodi adesivi sul lato posteriore e anteriore della falange del dito

indice.

| volontari sani dovevano seguire tre differenti task in ogni sessione

sperimentale:

e Task volontario, in cui al soggetto venivarichiesto di muovereil dito indice.
Il movimento doveva essere fatto in una finestra temporale di 10-13
secondi, a partire da un segnale acustico. Questo esperimento intende
racchiudere il movimento in una tempistica prefissata ma da spazio al
soggetto di effettuare una scelta volontaria, che varia quindi da persona a

persona e di volta in volta.
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e Task semivolontario, ripropone lo stesso movimento richiesto dal
protocollo precedente, ma questa volta il soggetto deve muovere il dito
indice non appena sente il segnale acustico.

e Task involontario, prevede che il riflesso patellare sia stimolato in
corrispondenza del tendine grazie ad un martelletto. Per questo
protocollo, il segnale acustico viene percepito solo dallo sperimentatore
che indossa delle cuffie, in modo che il soggetto non possa prevedere il
momento esatto in cui ricevera lo stimolo. Andando avanti con i

movimenti, il controllo dei muscoli volontarisi riduce fortemente.

Ciascuna sessione sperimentale si compone di 40 ripetizioni per ciascun
protocollo e il segnale acustico viene reso casuale per evitare che la mente in
qualche modo si adatti. Il segnale acustico viene emesso dal dispositivo Labjack
ed e convertito in un segnale di tensione attraverso il Labjack DAQ che lo
sincronizzacon le tracce EEG. Per organizzare |’esperimento, e stato utilizzato il
software OpenSesame, il quale permette allo sperimentatore, grazie ad una
finestra GUI, di scegliere innanzitutto il protocollo e successivamente il numero

di ripetizioni che il soggetto dovra effettuare.
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Figura 12: GUIdi Open Sesame

3.2 Set up sperimentale

e Galileo Suite di EB Neuro, utilizzato come sistema di acquisizione del
segnale EEG

e Computer con Software Galileo per visualizzare e salvare i dati

e Cuffia EEG, elettrodi adesivi, elettrodi di terra per EMG, elettrodi di
riferimento per EEG

e Pasta abrasiva NUPREP, gel conduttivo per EEG, siringa con ago smussato
per il montaggio della strumentazione

e Computer OpenSesame e Labjack per il segnale acustico

e Sistemi di supporto: carrello, sedia, tavolo.
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Figura 13: Materiale utilizzato durante 'esperimento

Lo stadio della preparazione ¢ il piu lungo ma anche il piu importante, perché
grazie ad una preparazioneadeguata e possibile ottenere una traccia EEG che sia
leggibile. Durante I'esperimento, sono stati usati due computer: uno, in cui e
presente il software OpenSesame, utilizzato per iniziare I'esperimento ed
emettere il segnale acustico; I'altro, in cui c’é invece il software Galileo, usato
per visualizzare, processare ed esportare i segnali acquisiti tramite la cuffia EEG
connessa. |l soggetto volontario viene fatto sedere su una sedia rialzata per
evitare che i piedi riescano a toccare il pavimento, per riuscire a realizzare il
protocollo involontario. Inoltre, il soggetto viene fatto sedere dietro il computer
con il software Galileo, mentre il secondo computer € posizionato sul tavolo
volto verso il lato opposto rispetto alla posizione in cui il soggetto e seduto, in
modo che non venga influenzato in nessun modo durante I'esperimento. A
guesto punto puo iniziare la preparazione per I'acquisizione del segnale. Prima
di tutto, gli elettrodi per la registrazione per gli EOG ed EMG vengono posizionati
utilizzando una pasta abrasiva dal nome TAN20 e successivamente si fa lo stesso
per posizionare gli elettrodi sui lobi auricolari e sul polso. Una volta che gli

elettrodi sono correttamente posizionati, viene fatta indossare la cuffia per EEG,
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provando a posizionare I'elettrodo Cz al centro tra Nasion e Inion e anche tra i
due elettrodi di riferimento sui lobi. A questo punto si deve pulire lo strato
cutaneo e si utilizza, quindi, la pasta abrasiva Nuprep, utile a rimuovereil sebo e
le cellule morte. Poi, in ciascuno degli elettrodi sulla cuffia viene inserito del gel
conduttivo, attraverso una siringa dall’ago smussato. Il gel conduttivo viene

utilizzato per due ragioni:

e Per migliorare la conduzione del segnale, abbassando lI'impedenza
dell’elettrodo in modo da ottenere un buon contatto tra lo stesso e la
pelle;

e Per migliorare I'adesione dell’elettrodo con la pelle, evitando cosi che

possa staccarsi durante qualche movimento.

Prima di acquisire il segnale EEG, lo sperimentatore deve valutare che

I'impedenza degli elettrodi non superi un certo valore di soglia, paria 10 kQ.

[[[[[

T

Figura 14: interfaccia grafica che mostra I'impedenza deglielettrodi.



Una volta finito I'esperimento, i materiali devono essere puliti, in quanto i residui
di gel secco sugli elettrodi possono essere una fonte di rumore, quindi si utilizza
una soluzione con alcool per gli elettrodi ai lobi e al polso e solo acqua per la

cuffia EEG.

Nelle sessioni sperimentali antecedenti rispetto a giugno 2018, 'EEG veniva
registrato da elettrodi sullo scalpo sulla corteccia motoria e premotoria; tutte le
registrazioni successive, invece, si basano sul sistema internazionale 10-10 ed in
tutto sono localizzati 32 elettrodi sullo scalpo, tutti che fanno riferimento agli
elettrodi posizionati sui lobi delle orecchie ed inoltre & utilizzato un elettrodo di
terra posizionato su Oz. |l segnale EOG viene rilevato dall’occhio destro e poi,
sia EEG che EOG, sono amplificati di 1000, grazie all’utilizzo dell’amplificatore

EBNeuro BE-Plus.
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Capitolo 4
Brain Computer Interface per pazienti non responsivi

4.1 Introduzione

| segnali EEG, come gia precedentemente detto, contengono informazioni
funzionalidel cervello, quindi I'analisi EEG e stata recentemente molto utilizzata
in molte applicazioni come la Brain Computer Interface, oppure per studi
cognitivi umani, diagnosi per malattie come l'epilessia. Il segnale EEG, pero,
contiene molto rumore causato dall’ambiente esterno e dalla strumentazione,
quindi c’e bisogno che il segnale venga processato per migliorare il rapporto

segnale rumore (SNR) per I'analisi.

Il software Galileo NT € uno strumento che permette di mostrare il segnale EEG
puro in real-time e di esportarlo in differenti formati, per riuscire poi ad usarlo
per la successiva manipolazione. Nei nostri esperimenti, abbiamo scelto di
salvarlo in formato “.asc”, con una frequenza di campionamento di 512 Hz e
abbiamo effettuato il salvataggio dei canali. Successivamente i dati sono stati
trattati attraverso Matlab 2019a, un ambiente di computazione numerica usato
per I'analisi dei dati. Attraverso Matlab si puo programmare con un linguaggio C,
creato da MathWorks, e si usano semplici comandi per la manipolazione di

matrici, creazione di grafici e manipolazione dei dati, in generale.

4.2 EEGLAB

EEGLAB € un toolbox interattivo di Matlab, creato da Swartz Center per la
Neuroscienza Computazionale (SCCN). EEGLAB viene utilizzato per processare i

biopotenziali: EEG, EOG e altri dati fisiologici. Esso permette di effettuare
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un’analisi utilizzando una grande varieta di funzioni per applicare filtri, rigettare
artefatti, fare la media e la statistica di eventi, visualizzare dati e altre funzioni
complesse sia nell’analisi del tempo che delle frequenze, tra cui I'analisi alle
componenti indipendenti (ICA). Inoltre, EEGLAB fornisce una interfaccia grafica
(GUI) per visualizzare dinamiche provenienti dal cervello relative ad eventi e per
immagazzinare e manipolare i dati dellEEG, attraverso funzioni gia
implementate, cosi come si possono scrivere funzioni per portare avanti

un’analisi real-time e automatica.

r 5

R

File Edit Tools Plot S5tudy ERPLAB ERPsets MRCPLAB Datasets Help E

—No current dataset

— Create a newWw or load an existing dataset:
Use "File > Import data™ (new)
Or "File > Load existing dataset™ (old)

— If new,
"File > Import epoch info" (data epochs) else
"File > Import event info" (continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset™ (save dataset)

— Prune data: "Edit > Select data™

- Reject data: "Tools > Reject continuous data™

- Epoch data: "Tools > Extract epochs"™

- Remove baseline: "Tools > Remove baseline"™

- Run ICA: "Tools > Run ICA"™

Figura 15: GUI di EEGLAB

4.3 MRPCLAB

Per elaborare i dati dell’EEG acquisiti dal software e stato sviluppato un plug-in
per EEGLAB. Questo plug-in permette di integrare tutti gli algoritmi implementati
con EEGLAB e aggiunge anche funzioni molto utili per analizzare il segnale

automaticamente, magariin previsione di una corretta identificazione dell’RP.
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4| EEGLAB v14.1.2 . | B S

File Edit Tools Plot Study ERPLAB ERPsets | MRCPLAB | Datasets Help L]
*** MRCPLAB v 4.3 ***
——No current dataset
Import/Save Data } Import from ASCI file and filter
e P W EEG Channels Operations Import from .sets file
ERP Operations [ Save all datasets

Use "File > Import dat
Or "File > Load existing dataset™ (old)

— If new,
"File > Import epoch info" (data epochs) else
"File > Import event info" (continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset™ (save dataset)

— Prune data: "Edit > Select data"™

— Reject data: "Tools > Reject continuous data"

— Epoch data: "Tools > Extract epochs™

— Remove baseline: "Tools > Remove baseline™

— Run ICA: "Tools > Run ICA"™

Figura 16: Menu di MRCPLAB

In particolare, da MRCPLAB compare un menu a tendina nel quale la voce
“Import/Save Data” & utilizzata per importare un dataset nello stesso formato
importato dal software ma hainoltre I'abilita di salvare tutti i dataset nel formato
“.set” erenderli compatibili con EEGLAB. Sempre nello stesso menu si trova “ERP
operation”, il quale, una volta che é stato importato il dataset, attraverso il
comando “ERP Computing” fa in modo che venga computato I'ERP e riesce a
mostrarlo tramite “ERP Viewer”. Quando si sceglie di processare un dataset nel
formato “.asc”, si apre una finestra interattiva, che chiede all’'utente di inserire

delle informazioni, come:

e Lafrequenzadi campionamento;

e La durata delle epoche, in secondi, in cui si divide il segnale, che € pari a
10 secondi se si considerano dataset acquisiti prima di Giugno 20180 e
paria 0 se si usa come segnale in ingresso quello del Labjack per i dataset
acquisiti dopo Giugno 2018;

e Ladefinizione delle epoche, in millisecondi, che e gia settata;
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e |l canale su cui si rileva il segnale EMG, che puo essere il canale 1, cioe
EMG1,oil canale 2, cioe EMG2.Inrealta, durante gli esperimenti di questo
progetto, e stato utilizzato un altro canale, detto “Pulsante”, per
I’acquisizione del segnale EMG, in quanto risultava esserci troppo rumore
nei due canali dedicati alla traccia EMG;

¢ |l nome del canale d’ingresso, che e il Labjack per gli esperimenti condotti
su volontari sani;

e Come ultima opzione si puo scegliere se si vuole ottenere a video solo la

traccia dellEMG o sia quella dellEMG che del segnale d’ingresso.

. ~
4. Dataset parameter I.il_lﬂ_hj

Sampling frequency (enter 0 to read from file):
0

Epoch duration in sec (0 if use cue channel ):
0

Epoch definition in ms (0 in the EMG onset)
-5000 3000

Entar EMG trace name
EMG1

Is EMG impulsive? (1 for yes)
0

Cue channel name {LabJack/Pulsante}
LabJack

EMG Plots (0 no plots, 1 only EMG, 2 also cue)

0

Figura 17: Pop-up window interattiva peril settaggio deiparametri

Dopo aver selezionato questi parametri, si acquisisce il segnale, si filtra e si
salva in un array di vettori che contiene tutte le informazioni riguardanti il
dataset. L'informazione poi e riportata nella GUI, come mostrato nella figura

seguente.
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Ta] EEGLAB V1412 =npay )
File Edit Tools Plot Study ERPLAB  ERPsets  MRCPLAB  Datasets  Help L]
—#1: EEG filt

Filename: ...ntaric\Datasets_E3\GO862071
Channels per frame 34
Frames per epoch 66048
Epochs 1
Events 38
Sampling rate (Hz) 128
Epoch start (sec) 0.000
Epoch end (sec) 515.992
Reference unknown
Channel locations Yes
ICA weights No
Dataset =size (Mb) 12.9

Figura 18: GUIl con i parametririepilogativi del datasetimportato

Tra le altre informazioni, troviamo anche quella che si riferisce al
posizionamento dei canali. Se in uno specifico file si conoscono i nomi dei
canali del dataset, le posizioni possono essere trovate automaticamente
all'interno del file Standard-10-5-Cap385.sfp, che € un database contenente
le etichette di 385 canaligia noti. Il file € gia presente nell’ambiente di EEGLAB
e le coordinate di ciascun elettrodo sono espresse nel sistema cartesiano.
Attraverso questo programma, € possibile visionare 'andamento del segnale
EEG nel tempo, che corrisponde ai 34 elettrodi registrati, insieme alle tracce

delllEOG destro e sinistro.

4.4 Classificazione dei dataset

Durante il mio lavoro di tesi, fra i dataset presenti nel database, mi sono
focalizzata su quelli successivi a giugno 2018. Ciascuno di essi € diviso in tre

task, cioe volontario, semivolontario e involontario. Prima di iniziare il
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processo di analisi e manipolazione, e stata fatta una classificazione basata

sull'ispezione visiva del segnale EMG e del Labjack.

0.08

——— LABJACK
EMG TKED
EMG VAR
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Figura 19: Visualizzazione del segnale, importato in formato .ascii

Nel grafico, il segnale EMG é rappresentato dalla curva blu, mentre la curva
magenta rappresenta la sua variabilita; il segnale Labjack & rappresentato
dalle linee verticali nere che indicano listante in cui inizia la finestra
temporale, cioé quando avviene la flessione dell'indice. Per fare
considerazioni sulla qualita del segnale EMG, ci siamo riferiti alla variabilita
del segnale stesso e a quanto apparisse rumoroso. Come ulteriore criterio, &
stato valutato I'onset del movimento, che € rappresentato da un punto verde.
Quandoil movimento e caratterizzato da unaflessione ampia e precisa, si puo
notare che il puntino verde & ben visibile sul grafico e non si sovrappone al
segnale; questo, invece, potrebbe capitare se il segnale EMG e troppo

rumoroso e se il movimento non e centrato sull’onset. |l segnale del Labjack
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non e sempre presente, questo perché lo strumento in sé connesso alla cuffia

EEG, puo produrrerumore a causa dell’'interferenza.

Nella nostra classificazione, sia il segnale EMG che quello del Labjack sono
stati valutati attraverso una scala che va da 0 a 3, in cui O sta ad indicare che
i segnali hanno una scarsa qualita, mentre 3 & I'esatto contrario. A questo
punto tutti i dataset sono stati rinominati attraverso una stringa di 45

caratteri, sulla base delle seguenti regole:

e || nome del soggetto e stato anonimizzato attraverso 8 caratteri,
riportando in successione la prima lettera del nome, la prima lettera
del cognome, 'ultima cifra dell’anno di registrazione, le ultime due
cifre dell’anno di nascita, il mese di nascita e poi il carattere 0 se il
soggetto e di sesso maschile, 1 se il soggetto e di sesso femminile;

e |l montaggio degli elettrodi dell’EEG e decifrato attraverso 5 caratteri:
32C18el'acronimo per il montaggio con la cuffia a 34 elettrodi, mentre
OBE12 e quello con gli elettrodi a ponte;

e 4 caratteri vengono impiegati per indicare il protocollo utilizzato per i
controlli, ovvero A18C indica il nuovo protocollo, B18C per il vecchio
protocollo e VOPCsi riferisce ai dati antecedenti al vecchio protocollo;

e |successivi 3 caratteri sono quelli che indicano se il soggetto e bendato
o0 no e in particolare I'acronimo FOL si riferisce ai soggetti bendati,
mentre UNF i non bendati;

e Per capire se il task utilizzato sia quello volontario, semivolontario o
involontario, si utilizzano 5 caratteri: VOL18, SEM18 0 INV18;

e Ancora 4 caratteri per il task: RFOF per right forefinger, LFOF per left
forefinger, BFOF per bimanual forefinger, RMOU per right mouse, RLEG
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per right leg, LLEG per left leg, RFOO per right foot, LFOO per left foot,
RHLE per mano+gamba destra, LHLE per mano+gamba sinistra;
e | successivi 4 caratteri indicano il canale utilizzo per EMG: EMG1 per il
canale 1, EMG2 per il canale 2, EMGX per il canale senza alcun numero;
e Infine, gli ultimi caratteri sono quelli che discriminano la qualita del
segnale EMG e del Labjack, quindi: E + 0/1/2/3 per 'TEMG e L+ 0/1/2/3
per il Labjack.

4.5 Metodi

| dati acquisiti dal segnale EEG sono importatiin MRCPLAB utilizzando la funzione
importtoEEGLAB.m. Prima di tutto, viene utilizzato il tasto ERP Computing,
attraverso la funzione di Matlab epochandfilter.m. Attraverso questa funzione,
non soltanto si calcolano gli ERP, ma prima di fare cio, I'intero tracciato EEG &
diviso in epoche, che sono estratte utilizzando la funzione pop_epoch.m. In
guesto modo, ciascuna epoca ha una finestra temporale che va da -5000 milli

secondi a 3000 milli secondi ed é allineata sullo zero allEMG onset.
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Figura 20: interfaccia che visualizza il tracciato EEG, insieme con EMG, EQJ e Labjack, dopo aver

effettuato ladivisione in epoche
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Per tutti i dataset la frequenza di campionamento e sotto campionata da 512 Hz
a128Hze, per evitareil fenomeno dell’aliasing, tutti sono filtrati. In primo luogo,
il segnale EEG viene preprocessato con un filtro passa-banda dai 0,016 Hz ai 70
Hz, con un amplificatore passa-banda da 0,001a 100Hz e un filtro notch a 50 Hz,
poi un filtro passa bassa con frequenza di taglio a 40 Hz e un filtro passa alto con
frequenza di taglio a 0,05 Hz. In questo modo, gli ERP possono essere calcolati
facendo la media fra le epoche, allineate sulEMG onset. In questa fase tutte le
epoche con artefatti evidenti vengono scartate, in quanto gli artefatti possono
causare un’interpretazione scorretta della forma d’onda dell ERP. Questa
procedura & portata avanti internamente ad EEGLAB, in cui inizialmente viene
osservato I'andamento temporale dell’intera traccia EEG, e poi, utilizzando il
pulsante “Edit Menu” e I'elemento “Select epochs or events”, possono essere
selezionate tutte le epoche da eliminare. In questo modo si crea un altro dataset,
che contiene tutte le epoche eccetto quelle con gli artefatti. Dal momento che
I'RP interessa la corteccia sensoriale-motoria, incluse le aree motorie e
premotorie, in corrispondenza del lobo frontale e della corteccia
somatosensoriale e del lobo parietale, vengono utilizzati sette canali: Cz, C3, C4
per I'area motoria; Fcz, Fc3, Fc4 per l'area premotoria; Pz per l'area

somatosensoriale.

Nello sviluppo di un metodo per la rimozione o la correzione degli artefatti
all'interno del progetto per la realizzazionedi una BCl, ho considerato un insieme
di dataset, che ho sottoposto ad un’accurata ispezione visiva. Nel caso in cui ho
ritenuto didover rimuovere I'artefatto, ho effettuato una divisione in epoche del
segnale e, sulla base di alcuni criteri, ho scelto di rimuovere quella specifica
epoca, eliminando cosi, sia la componente artefattuale che l'informazione

neuronale associata. Nel caso in cui ho cercato, invece, di effettuare una
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correzione dell’artefatto, mi sono servita di alcuni plug-in esterni al toolbox di
EEGLAB, ma compatibili con esso, ciascuno dei quali riesce ad effettuare una
correzione automatica o semiautomatica degli artefatti, basata sull’analisi alle

componenti indipendenti.

4.6 Analisi alle componenti indipendenti (ICA)

L’analisi ai componenti indipendenti € un metodo per processare un segnale in
modo da separare le sorgenti indipendenti linearmente tenute insieme da
diversi sensori. Si basa su una statistica indipendente. Se pensiamo all’'EEG, noi
abbiamo degli elettrodi che si posano sulla pelle, al di sotto della quale c’e la
corteccia. Vogliamo in qualche modo rilevare quello che ¢ il segnale prodotto da
ciascun singolo elettrodo e non il tracciato nella sua totalita. Quindi ICA € un
metodo per ricavare una versione del segnale che deriva dalle sorgenti originali,

moltiplicando il segnale con una matrice:
U= WX

Dove X rappresenta il segnale che registriamo, cioe i differenti canali nel tempo,
I’analisi ai componenti indipendenti mira a ricavare U, che & I'attivita originale e
rappresenta le diverse componenti nel tempo e W che & la matrice
moltiplicatrice (le componenti per i canali). L’analisi ai componenti indipendenti
tenta di rendere gli output statisticamente indipendenti, non ponendo alcun

vincolo alla matrice W.

Questo e un esempio in cui abbiamo due sorgenti, la sorgente a e la sorgente b
e abbiamo una combinazione lineare di queste due sorgenti. Sulla destra

vediamo i segnali che si ricavano dalla registrazione del segnale EEG e vogliamo
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ricavare le sorgenti a e b. Quindi applichiamo [l'analisi ai componenti

indipendenti e otteniamo il segnale originario.

Figura 21: immagine esplicativa delmetodo ICA

| primi studi riguardanti ICA derivano da Herault & Jutten nel 1986, seguito nel
1995 da Bell & Sejnoski. La prima applicazione di ICA a segnali biomedici e
avvenuta nel 1996 attraverso una analisi EEG/ERP e successivamente un’analisi
FMRI. | dati che derivano da un elettroencefalogramma possono essere
facilmente contaminati da segnali che non derivano dall’attivita cerebrale.
L’analisi ai componenti indipendenti puo aiutare a correggere 'EEG da questi
artefatti. Le componenti indipendenti artefattuali possono essere identificate
dagli esperti tramite ispezione visiva. Ma le caratteristiche degli artefatti sono un
po' ambigue e difficilmente comprensibili, e persino gli esperti potrebbero
trovarsiin disaccordo su come classificare un particolare componente. Quindi e
importante documentarsi sulle proprieta degli artefatti. La piu grande

problematica che riguarda l'interpretazione del segnale misurato sullo scalpo e
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che il segnale riflette un insieme di differenti sorgenti di attivita che hanno
origine esterna, quindi usare un metodo come [l'analisi ai componenti
indipendenti che permette di isolare le sorgenti di attivita indipendenti puo
essere utile. ICA permette lisolamento delle componenti statisticamente
indipendenti come combinazioni lineari degli elettrodi. Ciascuna componente e
caratterizzata da una sua topografia e un tempo. Le componenti indipendenti
posso essere intese come singoli elettrodi. In particolare, possono essere
sottratte al segnale esattamente come si pud pensare di togliere un cattivo
elettrodo dopo una registrazione. In questo modo il segnale e libero da artefatti
che erano concentrati proprio in quell’elettrodo. Le caratteristiche delle
componenti artefattuali possono essere visualizzate utilizzando svariate
rappresentazioni. EEGLAB offreun grandenumero di rappresentazionivisive che
permettono ad un osservatore allenato di identificarle, ma alcune caratteristiche
non sono immediatamente ovvie da queste rappresentazioni. Esistono un gran
numero di procedure automatiche che computano misure statistiche oggettive

nei segnali EEG.

L’analisi ai componenti indipendenti riesce ad isolare differenti categorie di
segnali. Nello specifico riesce a catturare una sorgente di attivita neurale, le
variazionidei potenziali dovute ai battiti di ciglia, i movimenti oculari, contrazioni
muscolare, rumore e elettrodi ad alta impedenza. C'e da dire che I'analisi ai
componenti indipendenti potrebbe fallire in quanto spesso molte componenti
non rientrano esattamente in una sola categoria. In pratica, separare classi
diversi di componenti indipendenti & quindi un problema che riguarda due
possibili errori: mancare componenti artefattuali o reputare come tali
componenti che non lo sono. Tutti i metodi automatici hanno dei propri criteri

per identificare almeno alcune di queste componenti.
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Tool Artifact type

SASICA Bli:tﬂ-tsjn"verﬁcal eye

movements

Horizontal eye movements

Muscle

Bad channel
Rare event
Non dipolar component
Bad channel

FASTER Eye blinks/saccades
“Pop-Off”

White noise

White noise
White noise
ADJUST Eye blinks
Eve blinks
Eye blinks

Vertical Eye Movements

Measure

Correlation with vertical EOG

electrodes

Correlation with horizontzl EQG

electrodes

Low autocorrelztion of time-course

Focal channel tepography

Focal trial activity

Residual variance

Correlation with Bad channel
Correlation with EOG electrodes
Spatial Kurtosis

Slope of the power spectrum

Hurst exponent

Median slope of time-course
Tempeoral Kurtesis

Spatial average difference
Spatial variance difference

Maximum epoch variance

Horizontal Eye Movements Spatial eye difference

Generic Discontinuities

Generic discontinuity spatial feature

Tabella 22: misure computate da questitre plug-in automatici.

Abbreviation

CorrV

CorrH

LoAC or

AuntoCorr
FocCh
FocTr
ResVar
CorrCh
EOGeorr
SK

Specsl

HE
MedGrad
TK

SAD

SVD
MEV
SED

GDSF
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Il successo dell'ICA nell’analisi EEG e in gran parte dovutaal fatto che la soluzione
ricavata sia davvero plausibile. Infatti, nella maggior parte dei casi, quando si fa
una prova su un dataset molto grande, la topografia e il corso del tempo di
almeno una manciata di componenti permettono la loro identificazione
attraverso la cattura selettiva dell’attivita neurale. Queste componenti sono
spesso dipolarie la loro topografia & regolare e liscia. Inoltre, spesso si collocano
tra le componenti piu forti nel dataset, ad esempio rappresentano quelle che
causano piu variazione nel segnale, contengono un picco di frequenze
fisiologiche e possono mostrare un’ampia risposta evocata ad uno stimolo
esterno. La natura dipolare di queste componenti puo essere misurata, in primo
luogo, adattando una sorgente dipolare alla componente e poi misurando la
varianza residua dopo aver rimosso i dati manipolati. Si pud notare che alcune
componenti con una bassa varianza residua possono essere artefatti. L’analisi ai
componenti indipendenti che cattura attivita neurale spesso contiene un picco
nel range Alfa (8-12 Hz), Beta (15-30 Hz), Delta (1-4 Hz), o Teta (5 Hz). Questo &
particolarmente vero per quelle componenti la cui topografia ha maggiore peso
sui sensori posteriori, medi o frontali rispettivamente per le frequenzeAlfa, Beta
e Teta. Infine, I'altra caratteristica fondamentale &€ quella di mostrare una
risposta evocata molto forte agli stimoli esterni. Pero, questa natura non sempre
puo essere diagnosticata perché non tutti i protocolli prevedono una
stimolazione e non tutte le componenti che mostrano una risposta evocata

possono essere classificati come attivita neurale pura.

L’analisi ai componenti indipendenti si dimostra davvero efficiente nel separare
I’attivita relativa ad un gran numero di artefatti da quella neuronale, isolando
automaticamente il segnale base in specifiche componenti indipendenti. Poiché
il numero di risorse e potenzialmente piu alto rispetto al numero di componenti

indipendenti, questa separazione non sara mai perfetta. In ogni caso, dopo aver
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rimosso gli artefatti non comuni attraverso un pre-processing del segnale, e
possibile ottenere una decomposizione alle componenti indipendenti pulita. C'e
da dire che l'usabilita pratica dell’analisi alle componenti indipendenti come
strumento per la rimozione degli artefatti ha un’importante limitazione: la
rilevazione delle componenti indipendenti associate ad artefatti richiede tempo
e coinvolge anche decisioni soggettive. Sono stati fatti diversi tentativi per
cercare di guidare la classificazione delle componenti indipendenti utilizzando
un numero di misure adeguato per discriminare le componenti artefattuali da

guelle non artefattuali sia nel dominio nel tempo che nel dominio dello spazio.

Vediamo, adesso, tre plug-in che ho nello specifico preso in considerazione:

SASICA, MARA e ADJUST.

4.7 SASICA

SASICA computa un numero di misurazioni sulle topografie di componenti
indipendenti e marca quelle che devono essere rigettate. Ciascuna misura puo
essere attivata o disattivata e le soglie possono essere adattate in base alle
richieste di un particolare dataset o un particolare studio. Dopo la computazione,
ogni misura o metodo € caratterizzata dal colore rosso che e usato per marcare

determinate componenti come artefatti. SASICA si basa su 6 misure:

n=1,2,...,Nindica lo specifico canale ( N € il numero di canali nel dataset);

e c=1,2,...,Cindicala specifica componente (C & il numero di componenti nel
dataset);

e k=1,2,...,Kindicauno specifico esperimento (K € il numerodi esperimenti);

e t=1,2,..Tindica lo specifico tempo di campionamento (T € il numero di

istanti presenti in ogni esperimento);
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e x(n,k,t) o x(ck,t): segnale EEG al canale n o alla componenti ¢, con
I’esperimento k e al tempo t;
e W.(n): peso inverso del canale n nella componente c;

e Z;(x): z-scoredix lungo la dimensione J (canali, tempo o esperimenti).

Per ciascuna di queste misurazioni presentate, viene settata una soglia per la
rimozione. SASICA permette diinserire sia una soglia assoluta dall’utente, sia una
soglia che si adatta e che seleziona le componenti il cui valore in una data
misurazione va oltre il numero delle deviazioni standard della media di tutte le
componenti per quel dataset. Per la maggior parte delle misurazioni, viene
settata la soglia di default pari a 2 per le deviazioni standard. Per le misure di

correlazionefrai canali, € raccomandata una soglia piu conservativa pari a 4.

61



4 Select ICA compenents - O >

Opticns u

m

=
El -
=

m

EOGSK EOGDX

g
g

Mo channel

Mo channel

Figura 23: GUIdi SASICA con le soglie da impostare, attraverso questafinestra operativa possiamo
scegliere il metodo oi metodida utilizzare per selezionare le componenti. Quandosi clicca sul
pulsante “Compute”, il plug-in computa tuttii metodiche sono stati attivati sul dataset che & stato

importato e mostra i risultati in successive finestre operative.
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4.7.1 Autocorrelazione

Le componenti che riflettono I'attivita cerebrale sono solitamente fortemente
autocorrelate. Questo significa che il livello del segnale in una componente in
gualsiasi punto del tempo solitamente e correlata con il segnale della stessa
componente qualche millisecondo prima. Al contrario, le componenti rumorose
come quelle muscolari, tendono a mostrare una bassa autocorrelazione.
Computare I'autocorrelazionediciascun componente € un modo per evidenziare
un’eventuale rimozione se il valore di autocorrelazione e al di sotto di una

III”

specifica soglia. L'autocorrelazione e definita come un ritardo per una

a_ n

componente “c” attraverso la seguente legge:

T A
o = E,!_—!" .‘-ﬁ{!r{i’.} - ‘r"{t - IE-.-I

Solitamente il ritardo e settato a 20 milli secondi, grazie al quale si riesce a
mostrare la migliore corrispondenzafrale classificazioni effettuate da esperti nei

dataset.

4.7.2 Focal topography

Le componenti che riflettono I'attivita neurale raramente coinvolgono un solo
elettrodo. Le componenti che hanno maggior peso solo su un elettrodo sono
guelle che maggiormente riflettono artefatti, piuttosto che attivita cerebrale.
Questa misura si effettua computando lo z-score del peso inverso dell’analisi ai
componenti indipendenti tra i canali. Le componenti che hanno un canale il cui
peso massimo assoluto supera la soglia sono considerate focali. La misura focale

della componente “c” e data da:

63



I 1113};'(%[ I-’L-Z{n.,l))

dove la quantita tra parentesi denota il massimo tra i canali.

4.7.3 Focal trial activity

Gli artefatti possono presentarsi con una grande ampiezza, ma in rare occasioni.
Quindi bisogna applicare una strategia che riesca a scovare eventi rari, allora,
piuttosto che misurare lo z-score dei pesi inversi delle componenti indipendenti
tra i canali, possiamo computare lo z-score di un range di attivita tra le
componenti indipendenti fra differenti esperimenti. Le componenti che hanno
delle prove che sono superiori alla soglia sono considerate focal trial activity.
Essa € espressa come segue:

FT, lTlﬁX.(Z (mfm{:aﬁ[c; k,t)) — mﬁiu{;n[c, k, t]}})

[ s

n

Dove max(k) e max(t) indicano rispettivamente il massimo fra gli esperimenti e

il massimo nel tempo.

4.7.4 Correlazione traicanali

| canali che sono fortemente contaminati da artefatti possono essere spesso
identificati prima degli altri, per come appaiono sul tracciato. Spesso questi
artefatti sono catturati in una singola componente della soluzione derivante da
ICA e questa componente € altamente correlata con il canale in questione.

Misuriamo la correlazione di specifici canali con tutte le componenti e settiamo
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una soglia per la rimozione. SASICA riesce ad utilizzare tre tipi di canali per
computare la correlazione fracomponenti indipendenti. Ha due campiper 'EOG
verticale e orizzontale e un campo per i “bad channels”. Se vengono inseriti due
canali per 'EOG verticale e orizzontale, automaticamente sara computata la
differenza fra quei canali. Questo serve ad incrementare il rapporto del rumore

del segnale prima di effettuare la correlazione con le componenti indipendenti.

Misure addizionali che vengono utilizzate per selezionare componenti, sia per la
rimozione ma anche per il processamento del segnale stesso sono: “weak signal

to noise ratio” ed “high residual variance of dipole model”.

e | e i
Figura 24: soglie individuate da SASICA. La soglia di selezione € mostratanella linea rossa presente in
ciascun pannello e ogni componente che superala soglia € evidenziata attraverso un colore specifico,
rispettoalla misura che sista considerando. Se si clicca su qualunque punto dellafinestra, siapre una

finestrache mostrain maniera dettagliata le proprietadelle componenti.
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|4 Reject compenents by map - pop_selectcomps() (dataset: EEG filt) -- SASICA 1 - O >

Cancel | Set threhsuld5| See comp. 5t...| See prnjectinn| Help | OK |

Figura 25: rappresentazione delle mappe topografiche diSASICA; in rosso sono evidenziate le
componentiindividuate come artefatti, in verde le restanti. Si possono notari i punti colorati che

indicano quali delle misurazioni computate hanno oltrepassato la soglia.
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Figura 27: da sinistra sono mostrati alcuni esempiin cui si mostra come SASICA riconosca componenti

artefattuali, rispettivamente, che derivano da movimentioculari, muscolari e dall’elettrodo.
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4.8 MARA

La rimozione dei canali attraverso I'analisi ai componenti indipendenti € basata
sullidea che le componenti artefattuali e I'attivita neuronale sono generate
indipendentemente. Il segnale EEG € decomposto in componenti indipendenti
nella speranza che le componenti artefattuali possano essere separate dal
segnale derivante dal cervello. Lo scopo del plug-in MARA ¢ quello di identificare
le componenti che sono maggiormente contaminate da artefatti, in modo da
poter poi ricostruire il segnale EEG senza di esse. MARA realizza una
classificazione automatica delle componenti indipendenti attraverso un
classificatore lineare precedentemente preparato. Si basa su sei criteri che sono
stati determinati attraverso una selezione delle caratteristiche. Una
caratteristica mira a localizzare le anomalie che ci sono nel tempo, tre
caratteristiche sono estratte dallo spettro e due caratteristiche estraggono

I'informazione dalla mappa dello scalpo di una componente indipendente.

e Current Density Norm: I'analisi alle componentiindipendenti, da sola, non
da informazioni circa la localizzazione delle componenti indipendenti. In
ogni caso la mappa dello scalpo puo essere interpretata come potenziali
EEG per i quali pud essere stimata, appunto, la localizzazione di ogni
sorgente. MARA considera 2142 locazioni organizzate in uno spazio di 1
cm disposte in una griglia 3D e cerca la distribuzione della sorgente con
una norma minima “I2”. Poiché la distribuzione della sorgente puo
modellare solo sorgenti cerebrali, &€ naturale che gli artefatti originati
dall’esterno del cervello possono essere modellizzati solo attraverso
sorgenti piu complicate. Queste sono caratterizzate da una norma I2 piu

grande.
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e Range Within Pattern: questo ¢ il logaritmo che si basa della differenzatra
I’attivazione minima e massima sullo scalpo.

e Mean Local Skewness: questa e la media assoluta locale dell’asimmetria
in intervalli di tempo di 15 secondi. Questa caratteristica mira a trovare
anomalie nel dominio del tempo.

e A\ e Fit Error: queste due caratteristiche descrivono la deviazione dello
spetto di una componente da una curva tipica 1/f e dalla sua forma.

e 8-13 Hz:questa e la banda media di potenza. Questa caratteristica mira a

decretare il tipico picco alfa in componenti di origine neurale.

Per far partire il plug-in MARA, si va in Tools, poi IC Artifact Classification (MARA),
poi MARA Classification:

Abaun

Figura 28: MenuU a tendina di EEGLAB

Siapre a quel punto una GUI come quella che segue:
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5.0.0 MARY,

Select preprocessing operations:
Filter the data
Run 1CA

After MARA clasaiflcation:

® Continue using EEGLab functions

) Piot and select components 1or removal
e Automatically remove COMponemMs

Cancel Ok

Figura 29: pop-up window interattiva del plugin MARA

Se il segnale non é stato precedentemente processato o non é stata ancora

effettuata I'analisi alle componentiindipendenti, si puo allora selezionare una di

queste funzioni da questa finestra. Successivamente MARA offre tre differenti

opzioni:

L'opzione di default e di utilizzare MARA solo per marcare le componenti
da rimuovere. In questo caso, pero, le componenti non verranno né
rimosse né visualizzate. A quel punto si devono utilizzare altre funzioni di
EEGLAB per approfondire l'investigazione.

Se invece si clicca su “Plot and select components for removal”, MARA
provvede ad una propria visualizzazione delle componenti indipendenti
che permette anche di modificare eventualmente la classificazione.
Neanche in questo <caso le componenti saranno rimosse
automaticamente.

Infine, se si clicca su “Automatically remove components”, si accetta
automaticamente la scelta di MARA che procedera a rimuovere alcune

componenti.
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Quando si sceglie di visualizzare le componenti, si apre una finestra come quella
che segue, in cui le componenti selezionate per la rimozione sono marcate di

rosso:

Reject components by map - pop_selectcomps( (dataset: EEG Data epochs)

Figura 30: rappresentazione delle mappe topografiche diMARA; in rosso sono evidenziate le

componentiindividuate come artefatti, in verde le restanti.

A guesto punto si puo decidere di plottare le proprieta di ciascuna componente
e cambiare il suo stato (Accept/Reject), cliccando sul pulsante rettangolare

presente:
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Figure 31: esempidimappe topografiche e dello spettro di potenzadeicanali IC3,IC7 e IC31 presiad

esempio.

Ad esempio, IC3, a sinistra, rappresenta un tipico artefatto oculare, infatti
notiamo una forte attivita frontale e un ripido spettro di potenza; IC7, invece, nel
mezzo, rappresenta una componente neurale con un picco alfa attorno ai 10 Hz
e dalla mappa si evince una sorgente cerebrale occipitale; infine, IC31, a destra,

e un tipico artefatto muscolare.

A scopo informativo, le finestre che mostrano per ciascuna componente le sei

caratteristiche su cuisi basa la classificazione di MARA sono mostrate di seguito:

Figura 32: interfaccia grafica che mostra i parametridi classificazione su cui si basa MARA
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Le caratteristiche che contribuiscono a reputare una componente come un
artefatto vengono plottate in rosso, quelle che indicano, invece, attivita

cerebrale sono marcate in blu.

4.9 ADJUST

ADJUST e un algoritmo completamente automatico che identifica componenti
indipendenti artefattuali combinando specifici artefatti spaziali e caratteristiche
temporali. | criteri sono stati ottimizzati per catturare movimenti oculari e
generiche discontinuita in un dataset. La classificazione che effettua ADJUST
delle componenti indipendenti si unisce a quella manuale che puo essere
effettuata da unesperto e la rimozionedelle componenti artefattuali evidenziate
da ADJUST porta ad una netta ricostruzione dei potenziali visivi e auditori event-
related. Questi risultati dimostrano che ADJUST fornisce un veloce, efficiente ed
automatico metodo che si basa sull’utilizzo dell’analisi ai componenti
indipendenti per la rimozione degli artefatti. Questo metodo si basa sulla
regressione dei segnali artefattuali, tipicamente registrati vicino agli occhi,
rispetto all’intero segnale EEG con un modello di propagazionedell’artefatto, sia
nel dominio del tempo che della frequenza. A causa, pero, del fatto che I'EEG e
I’attivita oculare si uniscono in modo bidirezionale, la regressione degli artefatti
oculari inevitabilmente porta alla rimozione di una rilevante porzione di segnali
neurali da ciascuna registrazione, cosi come attivita oculare. L’acronimo ADJUST
sta per “Automatic EEG Artifact Detection Based on the Joint Use of Spatial and
Temporal features”; questo plug-in automaticamente modella i suoi parametri
rispetto al segnale in modo da computare I'insieme di caratteristiche spaziali e
temporali relative agli artefatti di cui si ha bisogno per la classificazione delle

componenti indipendenti, senza informazioni aggiuntive. Il primo passo di
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ADJUST consiste nella decomposizione del segnale EEG in componenti
indipendenti. Vengono considerate quattro classi di artefatti: tre classi sono
relative agli artefatti ocularied unagenerica classe & deputata a catturareattivita
anomala registrata dai singoli elettrodi dovuta all’alta impedenza o alle
instabilita elettriche del dispositivo. Per ciascuna delle quattro classi di artefatti,
e stato implementato un rivelatore che computa un insieme specifico di
caratteristiche spaziali e temporali tra tutte le componenti indipendenti. Per
ciascuna, e stata stimata una soglia che divide gli artefatti dai “non-artefatti” su
tutto I'insieme di componentiin un modo completamente automatico. Per ogni
rilevatore, le componenti indipendenti sono classificate come artefatti se tutte
le caratteristiche sia spaziali che temporali di uno specifico artefatto
appartenente a quel rivelatore eccedono il loro rispettivo valore di soglia. Le
caratteristiche spaziali e temporali di ADJUST sono state ottimizzate in un
dataset di EEG basato su una “feature selection”. Poi ADJUST e stato validato con
un dataset di validazione attraverso un differente sistema EEG in un laboratorio
diverso e con un paradigma nuovo in relazione al dataset di selezione. La
validazione consta di tre passi: in primo luogo, la classificazione di ADJUST é stata
effettuata comparandolaad una classificazione manuale realizzata da tre esperti
indipendenti; in secondo luogo, & stato convalidato il vantaggio di utilizzare una
combinazione di caratteristiche; infine, e stata valutata la performance del plug-
in nella pulizia della topografia del segnale ERP affetto da artefatti comparando
gli ERP in seguito alla correzione di ADJUST con quelli ottenuti da dati non
soggetti a correzione e con quelli ancora ottenuti mediante classificazione

automatica degli esperti.
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Figura 33: esempio di topografie e andamento neltempo dell'ERP prima e dopo la correzione del

plug-in ADJUST



Capitolo 5

5.1 Risultati

La principale problematica comune a diversi studi su segnali EEG & che I'attivita
causata da artefatti ha tipicamente un’ampiezza maggiore rispetto a quella
cerebrale. Tipicamente per ricavare un ERP, il segnale viene diviso in epoche
bloccate nel tempo rispetto allo stimolo e gli artefatti sono rimossi
considerando e scartando, quindi, quelle epoche in cui I'attivita registrata
dall’EEG supera certe soglie predefinite, sia in specifici elettrodi, come ad
esempio quelli oculari, sia su tutti gli elettrodi posizionati sullo scalpo. In questo
modo, un ERP libero da artefatti puo essere ottenuto facendo la media del
segnale sulle epoche che sono rimaste, in modo che si incrementi il rapporto
segnale rumore. In ogni caso pero, questa procedura risulta complicata quando
sono disponibili solo poche epoche o quando gli artefatti sono davvero
frequenti, soprattutto negli studi che coinvolgono i bambini o i pazienti. Inoltre,
essa e inapplicabile negli studi che si focalizzano su attivita lenta che deriva dal
segnale EEG continuo, ad esempio oscillazioni cerebrali lente o correlazioni
temporali lunghe. Procedure alternative consistono nel modellare i segnali
generati da movimenti ocularie rimuoverlidal segnale, cercando di preservare

Iattivita restante.

Il presente capitolo ha lo scopo di ripercorrereil percorso di studio per I'analisi
degli artefatti che ho portato avanti durante il mio progetto di tesi. Sono partita
effettuando I'analisi ai componenti indipendenti e cercando frai diversi plugin
disponibili, quale mi desse migliori risultati. Solitamente, nella prima fase di
correzione, procedevo alla rimozione del canale o dei canali maggiormente

rumorosi. EEGLAB offre un metodo di rimozione automatica dei canali, tramite
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“Tools”-> “Automatic Channel Rejection”. Attraverso MRCPLAB, invece, e stato

implementato un algoritmo che decreta, in primo luogo, i canali plausibilmente

da eliminare, tramite “Seek Noisy Channe

I”

e, successivamente, |'utente puo

confermare la loro eliminazione, tramite “Select or Reject Data”. Questo

pulsante, in realta, permette di fare diverse cose, tra cui appunto la rimozione

del canale, precedentemente discriminato.

4\ Select data -- pop_select()

Select data in:

Time range [min max] (s)
Point range (ex: [1 10])
Epoch range (ex: 3:2:10)
Channel range

Help

Input desired range

Scroll dataset

O *
on->remove these
.
.
.
0|
Cancel | Ok

Figura 34: GUI di “Select or Reject Data”

Una volta superato questo step, procedo all’avvio dell’analisi ai componenti

indipendenti tramite “Run ICA”. A questo punto inizio le prove con i diversi

plugin; consideriamo ora il dataset GO862071 semivolontario.
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Figure 35: Channel Data Scroll di una finestratemporale che vada 0 a 5 secondi, prima e dopo aver

applicato “Automatic Artifact Rejection (AAR)”

77



Stack z Stack
s
Norm H Norm.
P‘JI Fp1
oz
A A
A A AaCAS S SASES S ey et e o A
A P A T A e [T I i e AN A o Akt e e
AT S Ay S S A
D A P A T e e e T T |3 et syt A A vyttt
i 6
EET W [ e T e e A Y e S
B b oAt e AR g ] B o A o e A i e e o]
A s T VvV e e o, SR AS A SO AR ATAA USSR A |
e e e oo A A SR e oo £ v smmsto ANV SN RN
&8 WMWW o o e e e A e
= Pt s by A PR TSR S A A A A
& o S RV VSV Vv vy A S A AP A
Wi VISV ISR A AP |

|
5

£ O I I T ]
[ s A A AR A A S AT A e e
Lo I T T e U IO — N AP 2 NSOV Sy VSO Sy W STV
G o e e e e VY See A AN ARvo eme ASY
N R A R e I ot —— o A e e N e S e iR

e A e s S A A a— [ TN %5‘2 e A o R A AP AP s AP~ AN A NS AN rocef A Scale
ey ARSIV A S v A AP A

R T e T T N s [P [ N e e e A e A L VS AY A A A v A S A

B T AV e R ) [ 5 e e e e A VAV AT ARV VA SO AT Ay B
o 1 2 3 4 5 0 1 2 3 4 5

Chan. Time  Value . Chan. Time Value -
CANCEL| Eventtypes| =< <[ 0 | =] 351 oy 17005 15080 | %0 j REJECT CANCEY Eventiypes| ==l k=l [ 0 | 31 B30 1 0011128 16213 |9 j REECT |
L Bal

Figure 36: ChannelData Scroll di una finestratemporale che va da 0 a 5 secondi, prima e dopo aver

applicato il plugin “IC Label(Indipendent Component)”
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Figure 37: ChannelData Scroll di una finestratemporale che va da 0 a 5 secondi, prima e dopo aver

applicato il plugin “MARA (Multiple Artifact Rejection Analysis)”
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Figure 38: ChannelData Scroll di una finestratemporale che va da 0 a 5 secondi, prima e dopo aver
applicato il plugin “SASICA (Semi-Automated Selection of Independent Components of the

electroencephalogram for Artifact correction)”

78



Quello che pero, ad una vista poco scrupolosa e veloce, pud sembrare un netto
miglioramento del segnale, si traduce, invece, in uno stravolgimento dello
stesso, che appare quasi identico su tutti i canali, situazione praticamente molto
poco realistica. Ho deciso, a questo punto, di proseguire nel mio studio solo con
I'utilizzo dei plug-in MARA e SASICA, che mi sono sembrati essere quelli piu
promettenti. Ho iniziato con il diversificare le varie soglie preimpostate, con lo
scopo di ottenere un risultato migliore ma mi sono ben presto resa conto che, in
realta, non esiste una scelta universale che si possa attuare e che sia valida per
tutti i dataset, ma che le soglie e i criteri di valutazione per la rimozione e la

correzione degli artefatti variano da segnale a segnale.

Da questo momento in poi ho iniziato a valutare i dataset attraverso la divisione
in epoche e la visualizzazione delle stesse, con lo scopo di riuscire a capire quali
possono essere considerate “buone” e quali debbano essere scartate, in seguito
ad ispezione visiva. Quindi importo il dataset in EEGLAB, effettuo “Epoch
Operation”, che divide il segnale in epoche; mi posiziono, allora, sul dataset
corretto e a quel punto posso far eseguire il codice che, dopo aver diviso il
segnale in epoche e aver decretato quelle da eliminare, somma e fa la media di
quelle buone, in modo da ottenere un ERP solo di epoche non contaminate da
troppi artefatti. Vado cosi a valutare gli ERP sui differenti canali. Posso poi
considerare di applicare il plug-in in continua solo sulle epoche che ho deciso di
scartare perché ritenute troppo contaminate da artefatti. Dal momento il
segnale ERP, come precedentemente detto, interessa la corteccia sensoriale-
motoria, incluse le aree motorie e premotorie, in corrispondenza del lobo
frontale e della corteccia somatosensoriale e del lobo parietale, vengono
utilizzati solo sette canali: Cz, C3, C4 per |'area motoria; Fcz, Fc3, Fc4 per I'area
premotoria; Pz per I'area somatosensoriale. Piu in avanti nel mio lavoro, ho

valutato esclusivamente gli elettrodi centrali e quelli sinistri, in base al fatto che
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durante gli esperimenti e stato rilevato il segnale EMG relativo al movimento
dell'indice destro (quindi considero solo elettrodi posizionati sull’emisfero

opposto, o al piu quelli centrali).

20 T 20 T T T T T T

15 15

10- g 10} 4
| ! | /\/\\/\
! SV ! f

5| 4 sl 4

-0 o}

A5 - 5|

20 L L g L L L 20 L L L L L L

5000 4000 3000 2000 -1000 0 1000 2000 5000 2000 000 2000 2000 o 1000 200

Figura 39: ERP del dataset GO862071 semivolontario sul canale Fcz prima dell’utilizzo del plugin, a
sinistra, e dopo I'attuazione di SASICA, adestra. Si puo notare come il plugin abbia interferito

sull’ampiezza dell’ERP.
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Figura 40: ERP del dataset GO862071 semivolontario sul canale C3 prima dell’ utilizzo del plugin, a
sinistra, e dopo I'attuazione di SASICA, adestra. In questo caso, 'ampiezza e rimasta pilt o menola
stessa; il plug-in ha eliminato alcune delle componentiartefattualipresentiprima dellEMG Onset,

nelle oscillazioni intorno allo zero.
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Sono state poi effettuate delle prove in cui si metteva a confronto lo stesso
dataset con un duplice scopo: da una parte, rimuovendo le epoche troppo
contaminate, ma senza aver applicato il plugin per la rimozione degli artefatti e
dall’altra, invece, senza aver rimosso le epoche troppo contaminate ma dopo
aver applicato il plug-in. Ovviamente si voleva cercare di mettere in evidenza la
validita del plugin, e se cid fosse stato vero doveva essere palese che I'ERP del
segnale in seguito all’utilizzo del plugin, applicato a tutte le epoche originarie,
doveva essere migliore di quello in cui sono state rimosse alcune epoche, ma
senza alcun utilizzo di plug-in. Cio, pero, non & mai stato vero, ad evidenza del
fatto che il segnale apparira sempre piu “pulito” se si sceglie di eliminare del
tutto le epoche troppo contaminate, anziché cercare di “aggiustare” lo stesso
attraverso plug-in, mantenendo tutte le epoche originarie. Tutto questo ci fa
concludere che I'utilizzo stesso del plugin porta con sé troppo segnale neurale

fondamentale e cid ha conseguenze negative sull’ERP.

A questo punto del lavoro ho iniziato a prendere in considerazione I'algoritmo
per il jitter compensation gia precedentemente implementato, il quale al suo
interno ha gia un suo criterio di eliminazione di epoche basato sulla cross-
correlazione tra i canali. Vediamo di seguito un esempio relativo al dataset gia

precedentemente considerato:
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Figura 41: in alto € mostrato|'RP del datasetin questione, in seguito ad una rimozione manuale degli

artefatti; in basso, I'RP € ottenuto dopo averanche utilizzato I'algoritmo di jitter compensation

Per capire se una rimozione manuale delle epoche potesse far ottenere risultati

migliori rispetto alla scelta interna all’algoritmo, ho effettuato numerose prove:
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Figura 42: nelriquardo in blu € mostrato|'RP del segnale in questione ottenuto tramite larimozione

delle epoche selezionate dall’algoritmo del jitter compensation; nello specifico esso elimina 13

epoche che sonoelencate. Neiriquadriin rosso, invece, ci sono gli RP che sono stati ottenutiin

seguito alla rimozione di epoche manualmente, che cambiano di prova in prova. Sono elencate le

epoche rimosse per ciascun grafico, in giallo sono evidenziate le epoche scelte che differiscono

rispetto a quelle scelte dall’

algoritmo.

83




Fino a questo punto la scelta per la rimozione viene effettuata guardando
epoca per epoca, tutti i canali insieme, ma focalizzandoci sugli artefatti che si
trovano molto vicini all’onset. Risultati nettamente superiori ho iniziato ad
averli nel momento in cui ho deciso di focalizzarmi su un canale principale,
scelto in base all'RP, da me ritenuto migliore. A questo punto ho iniziato a
valutare epoca per epoca ma sulla base di un solo canale, preferibilmente Fcz,
Cz, Pz, C3 o Fc3. Quindi attraverso la Command Window di Matlab, visualizzo

epoca per epoca sul canale scelto per quel dataset.

Plot (EEG.times, -smooth(signal original(1,:), 100), se ad esempio sto

visualizzando la prima epoca.

Effettuo cosi una scelta mirata all’ottenimento di un RP migliore, eliminando

guelle epoche che non danno un buon contributo al segnale nel suo complesso.
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Figura 43: dataset GO862071 semivolontario con 38 epoche originarie, RP otteunto sul canale Pz. A
sinistra I'algoritmo elimina le epoche: 8, 26, 34, 12, 28, 35, 3, 15, 5, 6, 29; a destra, ho scelto di
eliminare le epoche:3, 5, 6, 10, 12, 14, 15, 19, 24, 28, 29, 34, 35, 38.
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Figura 44: dataset GF892070 volontario con 39 epoche originarie, RP ottenuto sul canale Cz. A
sinistra, I'algoritmo elimina le seguentiepoche: 4,7, 21, 20, 39, 27, 5, 22, 19, 13, 32,24, 23; adestra,
ho scelto di rimuovere le epoche: 3, 4,5, 6,9, 13, 14, 19, 20, 21, 22, 23, 24, 27, 32, 33, 39.
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Figura 45: dataset CC994031 con 27 epoche originarie, RP ottenuto sul canale Cz. A sinista,
I'algoritmo elimina le seguentiepoche: 13, 8, 21, 6, 10, 14, 17, 5, 18, 23, 24; a destra, hoscelto di
rimuovere leepoche: 1, 3,5, 6,7, 8,9, 11, 13, 15, 17, 18, 20, 21, 22, 24, 27.
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Figura 46: dataset AL85070 con 37 epoche originarie, RP ottenuto sulcanale Fcz. A sinistra,
I'algoritmo elimina le seguentiepoche: 19, 37, 26, 25, 2, 28, 33, 27, 12, 17, 35, 18. A destra, ho deciso
dieliminare le epoche: 2, 6,7,9, 10, 11, 13, 16, 20, 24, 25, 27, 29, 31, 32, 33, 34, 37.

Ultimo step e stato quello di valutare il rumore di un dataset sempre
concentrandomisu uno specifico canale. Attraverso lo script rumore.m, valutoll
rapporto segnale rumore e lo plotto in modo che se I'ampiezza dellRP e
paragonabile all’ampiezza del rumore stesso, posso dedurre che quel segnale e
tutto inutilizzabile, quindi posso scartare il dataset. Se, invece, il rumore & di
molto inferiore all’lampiezza dell’RP, allora quel dataset € buono e si evince che
e stato corretto in maniera opportuna, in seguito alla rimozione delle epoche
giuste, in quanto troppo contaminate da artefatti. Per ogni dataset, ho fatto tre
prove: la prima considerando tutte le epoche originarie, quindi senza alcuna
rimozione, la seconda considerando l'algoritmo del jitter compensation e

successivamente considerando I’RP ottenuto sulla base delle mie scelte.
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Figura 47: dataset GO2071, task semivolontario. Da sinistra a destra, sono mostratigli RP el

rapporto segnale rumore nel caso in cui vengano utilizzate tutte le epoche originarie, nel caso in cui,

si eliminano automaticamente le epoche decretate dall’algoritmo deljitter compensation e infine

sulla base di una scelta manuale, tramite ispezione visiva.
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Figura 48: dataset GF892020, task volontario. Da sinistra a destra, sono mostrati gli RP e il rapporto

segnale rumore nelcaso in cui vengano utilizzate tutte le epoche originarie, nel caso in cui, si

eliminano automaticamente le epoche decretate dall’algoritmo del jitter compensation e infine sulla

base di una scelta manuale, tramite ispezione visiva.
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Figura 49: dataset CC994031, task semivolontario. Da sinistra a destra, sono mostratigli RP e il

rapporto segnale rumore nel caso in cui vengano utilizzate tutte le epoche originarie, nel caso in cui,

si eliminano automaticamente le epoche decretate dall’algoritmo deljitter compensation e infine

sulla base di una scelta manuale, tramite ispezione visiva.
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Figura 50: dataset AL858070, task semivolontario. Da sinistra a destra, sono mostratigli RP e il

rapporto segnale rumore nel caso in cui vengano utilizzate tutte le epoche originarie; nelcaso in cui,

si eliminano automaticamente le epoche decretate dall’algoritmo deljitter compensation e infine

sulla base di una scelta manuale, tramite ispezione visiva.

Per stilare delle regole che possano essere le fondamenta per un futuro sviluppo

di un algoritmo per la rimozione automatica o semiautomatica delle componenti

artefattuali, mi sono focalizzata su un’ispezione visiva accurata del segnale EEG

relativamente allo specifico canale, insieme con EMG ed EOG. Questo per vedere

I'influenza che questi segnali hanno uno sull’altro, in termini di artefatti.

88



5.2 Regole perlarimozione delle epoche

Dai grafici che si ottengono tramite “Channel Data Scroll” di EEGLAB,
valutare il tracciato EEG del solo canale preso in considerazionee
confrontarlo con il tracciato EMG e EOG dello stesso dataset, per capire
le influenze che determinati artefatti muscolari o oculari possono avere
sul mio segnale ed in particolare su quel canale. Dopo effettuare una
valutazione generale con i 7 canali insieme che interessano I'RP: Cz, Fcz,
Pz, C3, Fc3,C4, Fca.

Filtrare tra 0,1 Hz e 4 Hz, ma se i canali sembrano apparire cosi tutti
uguali, provare senza filtro e poi dividere in epoche. | filtri sono usati per
rimuovere cambiamenti di tensioni molto lenti e molto veloci.

Se I'artefatto compare su tutti i canali, I’epoca é da eliminare tramite
criteri di crosscorrelazione.

Valutare sempre in un primo step gli artefatti oculari e se questi incidono
nel tracciato EEG su tutti i canali, compreso quello che si sta
considerando.

Se "'ampiezza del picco dell’oscillazione supera i 1/3 di 100 microVolt,
bisogna eliminare quell’artefatto. Dalla letteratura si evince che si
potrebbe arrivare ad un valore di pilt 0 meno 75 microV, ma questa
soglia puo andar bene solo per blink rejection. Quindi si deve valutare
una soglia, a seconda del tipo di artefatto.

Se artefatto & presente solo sui 7 canali, allora probabilmente sara un RP.
Se compare anche su tutto il resto probabilmente sara un artefatto.
Un’epoca con un EEG che non oscilla, ma é totalmente ascendente o

discendente va eliminata.
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e Andamenti lenti sono quasi sicuramente artefatti oculari da eliminare,

invece oscillazioni troppo fitte non per forza causano problemi.
Considerare una durata di oscillazione dell’EEG, cioe dallo zero allo zero
nuovamente, compresa entro 0,15 secondi, o analogamente pari a 6-7
Hz. In letteratura e esplicitato un metodo detto “Moving window peak-
to-peak amplitude”, che definisce una durata pari a 200 milli secondi,
come ampiezza della finestra temporale. L’algoritmo pone questa
finestra all’inizio di ciascuna epoca e cerca la differenza fra un picco e
I’altro come la massima differenza tra il maggiore frai valori positivi e il
maggiore frai valori negativi nella finestra. La finestra e poi spostata sulla
destra di una quantita definita dall’utente e viene definita una nuova
ampiezza fra i picchi in questa nuova finestra. La differenza piu ampia
che viene ricavata, € poi comparata con la soglia definita per la rimozione
degli artefatti.

Ho riscontrato I'importanza del confronto tra EEG ed EMG e/o EOG in
letteratura, ovviamente sia per quel che concerne la preparazione del
paziente prima della rilevazione del segnale sia nell’analisi a posteriori
per la rimozione del rumore dal segnale EEG.

E difficile definire una soglia univoca a cui affidarsi nell’analisi per la
rimozione degli artefatti, in quanto la scelta di una soglia comportasia la
guantita di artefatti rimossi che la quantita di segnale neurale che viene
distorto allo stesso tempo. Una soluzione possibile & utilizzare una soglia

universale proposta da Safieddine et Al., 2012 :

T,l = I::f; "l..-l In N,

In cui N rappresenta la lunghezza del segnale, j € la stima della varianza

del rumore di Wj che si calcola secondo la seguente formula:
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median(|W;|)
Y= TT0.6745

e Valutare la presenza di RP su un sottogruppo di canali (tra cui appunto
C3,C4, Pz, Fcz, Cz, Fc3, Fc4)

e Le caratteristiche comuni all’'onda RP sono le seguenti: 'ondasi alza
lentamente verso I'alto a circa 1600 milli secondi prima dell’inizio del
movimento. |l picco dell’'onda compare tra circa 400 e 120 milli secondi
prima del movimento e continua a decrescere dopo il movimento stesso.
Utilizzando queste soglie per discriminare I'RP, si pu0 piu facilmente
differenziare un artefatto, che non rispetta appunto questi criteri.

e Cisono diversi plugin che rimuovono gli artefatti oculari sia nel dominio
del tempo che della frequenza, allora se si riesce ad eliminare un
artefatto oculare piu facilmente, ne consegue che il riconoscimento e
conseguente eliminazione degli artefatti sul canale EEG potrebbe
risultare meno complesso.

e Eimportante indagare metodi di cross correlazione, utilizzare filtro

spaziale e valutare il rapporto segnale rumore.

Per concludere il mio processo e fare delle ultime considerazioni, ho effettuato
differenti provein cui prima ho dato in input al plugin un dataset gia pulito dalle
epoche troppo contaminate e poi ho fatto il procedimento inverso, cioé ho
attuato primail plug-in per poter poi, successivamente, effettuare una rimozione
delle epoche, che a questo punto sara sicuramente piu limitata, in quantoil plug-
in ha gia effettuato una prima correzione. | risultati relativi al dataset GO862071,
per il task semivolontario sono visualizzati di seguito e le considerazioni sono

sempre fatte sulla base di come apparel’RP.
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Figure 51: a partire, in alto, dallo stesso RP delsegnale GO862071, semplicemente importato e diviso
in epoche, a sinistra: il segnale & stato sottoposto primaa correzione degliartefatti, grazie all’ utilizzo

del plug-in SASICA e dopoi restanti artefattisono stati eliminati, tramite la rimozione di opportune
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epoche; a destrainvece, e stato fatto il processoinverso, cioé si visualizza I'RP del segnale che prima
e stato sottoposto a rimozione delle epoche troppo contaminate e dopo & stato applicato lo stesso
plug-in. Risultati migliori si riscontrano nel processo di sinistra, in cui il rapporto segnale rumore e

davvero basso, rispetto al’ampiezza dell’RP, in concomitanza dell’onset.

5.3 Discussione

L’applicabilita di algoritmi automatici, come i plugin precedentemente
approfonditi, basati sull’analisi ai componenti indipendenti, porta a dei risultati
discreti per quel che concerne la pulizia del segnale dalla presenza di artefatti
ed, inoltre, velocizza anche i tempi di lavorazione per I'utente. Analizzando i
risultati, € plausibile come questi metodi riescano ad identificare buona parte
degli artefatti presenti, ma bisogna prestare molta attenzione al fatto che non
venga denaturato il segnale stesso. Gli artefatti oculari sono quelli piu
facilmente riconoscibili ed eliminabili da parte degli algoritmi automatici. E di
fondamentale importanza, quindi, ricorrere ad una rimozione delle epoche per
perfezionareil processo, prima o dopo I'applicazione del plugin. In questo
lavoro, si e effettuata una rimozione manuale delle epoche troppo rumorose e
si € posta la base per un futuro sviluppo di un algoritmo automatico per la
rimozione delle stesse, sulla base di differenti criteri. Si & cercato, inoltre, di
mantenere almeno 15 epoche sui dataset a nostra disposizione, che sono in

media dotati di 35 epoche.

Come si evince dagli ultimi grafici, il rapporto segnale rumore mostra quantoiil
segnale sia corrotto da rumore. In particolare, esso cresce subito dopo I'onset
dellEMG. Il dataset GO862071 del task semivolontario, che é stato
maggiormente analizzato, € uno dei dataset con la forma d’onda dell’'RP
migliore, fra quelli a disposizione. Grazie al parametro SNR, quindi, si puo

evincere quanto e ampio il potere del segnale rispetto a quello del rumore.
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Per quanto qualsiasi strumento automatizzato possa velocizzare i tempi di
esecuzione e portare a dei miglioramenti sul segnale, & sempre opportuno
integrare metodi automatici con contributi manuale da parte dell’'utente sulla
base di una precedente ispezione visiva. In questo modo e possibile adattare
un criterio piuttosto che una soglia allo specifico segnale che si sta analizzando,
attuando cosi un piano di rimozione degli artefatti “personalizzato”, che possa

portare ai migliori risultati ottenibili.
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Conclusioni

Questo lavoro di tesi si basa sulla rilevazione di biosegnali in un esperimento
finalizzato all’'individuazione dei Readiness Potential e propone un protocollo di
acquisizione. Dopo la fase sperimentale si € proceduto con lo sviluppo di un
metodo per la rimozione degli artefatti, all’interno di un grande progetto, che &
quello della realizzazione di una Brain Computer Interface, per pazienti non
responsivi. La mia tesi fa parte di un lavoro molto ampio, iniziato nel 2012 eche
oggi riesce ad andare avanti con la collaborazione del Centro Puzzle di Torino e
di molte figure professionali. Riuscire a rilevare il livello di coscienza nei

pazienti con un minimo errore nella diagnosi €, ancora oggi, una grande sfida.

E stato esposto, quindi, il protocollo di controllo utilizzato finora; esiste un
protocollo pazienti da utilizzare sui pazienti per la registrazione del segnale EEG
e laricerca dell’RP e si continuera ad acquisire il segnale anche su altri soggetti

di controllo per ampliare il numero di dataset a disposizione per lo studio.

Nell’analisi dei dati che sono stati ottenuti durante I'attivita sperimentale, si
evince che e di fondamentale importanza dedicare maggiore attenzione alla
fase di acquisizione, in particolare al momento del montaggio degli elettrodi,
nonché farein modo di eseguire I'esperimento nel modo piu corretto possibile.
Infatti quanto piu si riesce a registrare un segnale pulito e privo di artefatti e di
rumore, piu sara facile rilevare il segnale ERP. In questo modo, si pu0 lavorare
su dei segnali che, di base, si presentano piu chiari e sara quindi piu semplice
procedere all’individuazione e alla rimozione degli artefatti. Infatti, laddove non
si e riusciti ad ottenere una forma d’onda canonica di un RP, la motivazione
risiede proprio nel fatto che il segnale e troppo rumoroso o troppo

contaminato da artefatti.
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Per le acquisizioni future, quindi, si consiglia di prestare piu attenzione e
precisione al montaggio degli elettrodi, cercando di ottenere minimi valori di
impedenza. Si deve, inoltre, fare in modo che il soggetto resti quanto piu fermo
possibile e non parli durante |’esecuzione, pensando anche alla deglutizione e
al movimento istintivo delle palpebre, concentrandosi solo al movimento da
compiere. Un passo avanti nel proseguimento di questo lavoro potrebbe essere
guello diinvestigare il livello di coscienza in pazienti non responsivi, che si
trovano in uno stato vegetativo o di minima coscienza. Il rapporto segnale
rumore potrebbe indicare I'indice di coscienza perché, attraverso questo
parametro, si puo leggere l'intenzione di compiere un movimento all’interno
del segnale stesso. Partendo dall’onset del movimento, dove c’eé la maggior
parte del segnale, si puo dedurre quanto il soggetto e cosciente nella sua

intenzione di effettuare un movimento.
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